On Disk:
More than 20 Hip Shareware and Freeware Programs
- Lets You Jazz Up and Personalize Your Mac
- For Systems 6, 7, and 7.1
<table>
<thead>
<tr>
<th>Icon</th>
<th>Program Name</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Before Dark icon" /></td>
<td>Before Dark</td>
<td>Replaces the small standard desktop patterns with intricate color patterns up to 256 pixels on a side, much like the commercial program Chameleon.</td>
<td>30</td>
</tr>
<tr>
<td><img src="image" alt="Bongo Bob icon" /></td>
<td>Bongo Bob</td>
<td>Displays one of over 100 wacky sayings every time you restart the Mac, and you can easily add as many of your own messages as you like.</td>
<td>16</td>
</tr>
<tr>
<td><img src="image" alt="DarkSide icon" /></td>
<td>DarkSide</td>
<td>A screen saver that displays animations during periods of inactivity, much like the commercial program After Dark. It even runs After Dark modules!</td>
<td>66</td>
</tr>
<tr>
<td><img src="image" alt="FKEY Master icon" /></td>
<td>FKEY Master</td>
<td>A utility for installing function keys (FKEYs) such as The Ripper.</td>
<td>132</td>
</tr>
<tr>
<td><img src="image" alt="Kilroy icon" /></td>
<td>Kilroy</td>
<td>If you wait too long, a bald-headed Kilroy peeks over dialog boxes and his eyes follow the cursor.</td>
<td>80</td>
</tr>
<tr>
<td><img src="image" alt="Lights, Camera, Action! icon" /></td>
<td>Lights, Camera, Action!</td>
<td>Plays animation files during startup, complete with soundtracks if you want.</td>
<td>21</td>
</tr>
<tr>
<td><img src="image" alt="Makin' Copies icon" /></td>
<td>Makin' Copies</td>
<td>Says &quot;Makin' copies!&quot; whenever you duplicate files, disks, or folders, just like the hilarious Saturday Night Live skit.</td>
<td>61</td>
</tr>
<tr>
<td><img src="image" alt="MICN icon" /></td>
<td>MICN</td>
<td>Replaces the text in the menu bar with icons of your choosing. Useful for reclaiming space in cramped menu bars such as on PowerBooks.</td>
<td>89</td>
</tr>
<tr>
<td><img src="image" alt="Momentum icon" /></td>
<td>Momentum</td>
<td>Allows you to &quot;throw&quot; outlined objects around the desktop, complete with bouncing sound.</td>
<td>100</td>
</tr>
<tr>
<td><img src="image" alt="99 Bottles icon" /></td>
<td>99 Bottles</td>
<td>Sings &quot;99 Bottles of Beer on the Wall&quot; at various speeds with any number of bottles of beer.</td>
<td>42</td>
</tr>
<tr>
<td><img src="image" alt="PICT2Startup icon" /></td>
<td>PICT2Startup</td>
<td>Converts PICT graphics into StartupScreens for display during startup.</td>
<td>2</td>
</tr>
<tr>
<td>Icon</td>
<td>Program Name</td>
<td>Description</td>
<td>Page</td>
</tr>
<tr>
<td>----------</td>
<td>----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>ScreenChooser</td>
<td>Randomizes the startup screen to keep things interesting, then replaces the boring desktop pattern with either your full-color startup screen or large, repeating tiles.</td>
<td>7</td>
</tr>
<tr>
<td><img src="image2.png" alt="Icon" /></td>
<td>ShrinkDown</td>
<td>Shrinks screen to a little dot upon Shutdown, just like an old television set being turned off.</td>
<td>114</td>
</tr>
<tr>
<td><img src="image3.png" alt="Icon" /></td>
<td>Shutdown Fade</td>
<td>Fades screen upon Shutdown instead of just going black in a flash.</td>
<td>116</td>
</tr>
<tr>
<td><img src="image4.png" alt="Icon" /></td>
<td>SndControl</td>
<td>Plays sounds corresponding to various events such as emptying the Trash and ejecting disks. Comes with a dozen authorized Star Trek sound effects.</td>
<td>47</td>
</tr>
<tr>
<td><img src="image5.png" alt="Icon" /></td>
<td>Sound Mover</td>
<td>Moves sounds between files so they can be used by StartupSnd or SndControl.</td>
<td>122</td>
</tr>
<tr>
<td><img src="image6.png" alt="Icon" /></td>
<td>StartupSnd</td>
<td>Impresses your friends by playing the Quadra startup chord—or any other sounds—upon startup.</td>
<td>26</td>
</tr>
<tr>
<td><img src="image7.png" alt="Icon" /></td>
<td>SuperApple</td>
<td>Replaces the static Apple icon with various color animations such as a bouncing ball or waving flag.</td>
<td>84</td>
</tr>
<tr>
<td><img src="image8.png" alt="Icon" /></td>
<td>TailDragger</td>
<td>Causes the cursor to point in the direction of the mouse movement.</td>
<td>97</td>
</tr>
<tr>
<td><img src="image9.png" alt="Icon" /></td>
<td>The Ripper</td>
<td>Tears the current window, leaving it fully functional, but with a jagged edge.</td>
<td>105</td>
</tr>
<tr>
<td><img src="image10.png" alt="Icon" /></td>
<td>Wacky Lights</td>
<td>Makes the LEDs on keyboard flash in a back-and-forth sequence.</td>
<td>108</td>
</tr>
</tbody>
</table>
What Readers Have to Say about
Totally Rad Mac Programs

"Keep up the good work and maybe someday you might attain Mother Teresa status as the living patron saint of Macheads."

Philip S. Bacalzo
Oxnard, California

"The programs bring an otherwise boring computer session to life."

James Turner
Springfield, Oregon

"All the stuff on the disk is fun to use, and with them I have greatly increased the coolness of my Mac."

Paul Zurcher
Corvallis, Oregon

"Your book was both entertaining and informative, and worth much more than the price paid."

James R. Wurzer
Fresno, California

"What an excellent book! Thanks for making my Mac fun again."

George L. Hazelwood
Lakewood, Colorado

"Totally Rad Mac Programs is the coolest pack of programs and extensions I have ever seen."

Tony Hauth
Salem, Oregon

"It is a small price to pay for entertainment nowadays."

Steve R. Breeden
Kalispell, Montana

"Thanks again for creating a totally useless and, therefore, totally enjoyable book."

James L. Ross
Cincinnati, Ohio

"I can't begin to tell you how much I've enjoyed using the programs contained in your book."

Jeremy J.C. Milani
Spofford, New Hampshire

"I recently purchased your book and found it both enjoyable and useful. A better bargain than buying After Dark."

Larry W. Falbe
Niles, Illinois

"Thanks for making these great programs more accessible to those of us who still don't telecommunicate."

Carlton A. Lamb
New Orleans, Louisiana

"I am really impressed with Totally Rad Mac Programs. Keep up the good work. I'll buy every book you put out to make the Mac fun to use."

Randy Thiessen
Kelowna, British Columbia, Canada
“Thanks for saving me a whole lot of hours digging up fun software to run on my Mac.”

Noel R. Caban
New York, New York

“This book is the best collection of software I’ve ever seen! Great fun! Fantastic stuff! My Mac has never looked better.”

Michael S. Harrigan
Albuquerque, New Mexico

“Great book. By far providing the utmost fun in the realm of goofy Mac program books.”

Zack Flip
Tucson, Arizona

“You have created a great book!! This shareware collection is one of the best I have ever seen. Each program is useful and very well done.”

Scott Seifert
Lakewood, Ohio

“A marvelous collection of really pointless time wasters.”

Andrew Gillanders
Brisbane, Queensland, Australia

“Having bought your book/disk combo, I was thrilled when I tried the programs out. I have also purchased Stupid Mac Tricks and Son of Stupid Mac Tricks and I think this set is better.”

James A. Arnold
Hilliard, Ohio

“The book was a fun read, easy to follow, and the programs are great for customizing my new Quadra 700.”

Mark Meloche
Downsview, Ontario, Canada

“Let me say how great this book is. I think it’s bad ass!”

Michael Cluff
Carrollton, Texas

“I’ve seen the rest and this one is the best.”

Patrick M. Grehan
Uniondale, New York
Books that Work Just Like Your Mac

As a Macintosh user, you enjoy unique advantages. You enjoy a dynamic user environment. You enjoy the successful integration of graphics, sound, and text. Above all, you enjoy a computer that's fun and easy to use.

When your computer gives you all this, why accept less in your computer books? At SYBEX, we don't believe you should. That's why we've committed ourselves to publishing the highest quality computer books for Macintosh users. Externally, our books emulate the Mac "look and feel," with powerful, appealing illustrations and easy-to-read pages. Internally, our books stress "why" over "how," so you'll learn concepts, not sequences of steps. Philosophically, our books are designed to help you get work done, not to teach you about computers.

In short, our books are fun and easy to use—just like the Mac. We hope you find them just as enjoyable.

For a complete catalog of our publications:
SYBEX Inc.
2021 Challenger Drive, Alameda, CA 94501
Tel: (510) 523-8233/(800) 227-2346 Telex: 336311
Fax: (510) 523-2373

SYBEX is committed to using natural resources wisely to preserve and improve our environment. As a leader in the computer book publishing industry, we are aware that over 40% of America's solid waste is paper. This is why we have been printing the text of books like this one on recycled paper since 1982.

This year our use of recycled paper will result in the saving of more than 15,300 trees. We will lower air pollution effluents by 54,000 pounds, save 6,300,000 gallons of water, and reduce landfill by 2,700 cubic yards.

In choosing a SYBEX book you are not only making a choice for the best in skills and information, you are also choosing to enhance the quality of life for all of us.
Totally Rad Mac Programs
Totally Rad Mac® Programs
Second Edition

Owen W. Linzmayer
SYBEX warrants the enclosed disk to be free of physical defects for a period of ninety (90) days after purchase. If you discover a defect in the disk during this warranty period, you can obtain a replacement disk at no charge by sending the defective disk, postage prepaid, with proof of purchase to:

SYBEX Inc.
Customer Service Department
2021 Challenger Drive
Alameda, CA 94501
(800)227-2346
Fax: (510) 523-2373

After the 90-day period, you can obtain a replacement disk by sending us the defective disk, proof of purchase, and a check or money order for $10, payable to SYBEX.

SYBEX makes no warranty or representation, either express or implied, with respect to this software, its quality performance, merchantability, or fitness for a particular purpose. In no event will SYBEX, its distributors, or dealers be liable for direct, indirect, special, incidental, or consequential damages arising out of the use or inability to use the software even if advised of the possibility of such damage.

The exclusion of implied warranties is not permitted by some states. Therefore, the above exclusion may not apply to you. This warranty provides you with specific legal rights; there may be other rights that you may have that vary from state to state.

Shareware is a distribution method, not a type of software. The chief advantage is that it gives you, the user, a chance to try a program before you buy it.

Copyright laws apply to both shareware and commercial software, and the copyright holder retains all rights. If you try a shareware program and continue using it, you are expected to register it. Individual programs differ on details—some request registration while others require it. Some request a payment, while others don't, and some specify a maximum trial period. With registration, you get anything from the simple right to continue using the software to program updates.

None of the programs on the disk is copy-protected. However, in all cases, reselling these programs without authorization is expressly forbidden.
Dedicated to my wife, Alane, who stayed out of my hair while I was writing this book, and to my cat, Nutella, who didn’t.
Acknowledgments

While the cover of this book bears my name alone, I could not have written it without the contributions of many others to whom I am deeply indebted. (Yeah, I know every humble author says the same thing, but in this case it's really the truth!)

Foremost among those I'd like to thank are the programmers who hacked together the totally rad programs included with this book (listed in reverse alphabetical order just to be different): Jim Wolff (Makin' Copies), Andrew Welch (Wacky Lights), Dan Venolia (original TailDragger), Mark Valence (MICN), Marcio Luis Teixeira (ScreenChooser), Jim Stegman (Momentum), Adam Stein (FKEY Master), Roby Sherman (Bongo Bob), Andrew McGeachie (Shut-down Fade), Craig Marciniak (Before Dark), Robert S. Mah (Lights, Camera, Action!), Dave Koziol (Kilroy), Bill Johnson (Momentum), Eric J. Hayes (Makin' Copies), Jay Geagan (99 Bottles), Scott Fenton (ShrinkDown), Riccardo Ettore (SndControl, Sound Mover, and StartupSnd), Tom Dowdy (DarkSide), Chris Derossi (PICT2Startup), Jan Bruyndonckx (SuperApple and revised TailDragger), and Steve Blackstock (The Ripper). To all of you, thanks a million. May your cups runneth over with Jolt cola and your mailboxes overflow with the shareware fees you so richly deserve.

I'd also like to thank the many individuals who helped by offering tips, leads, and suggestions for improving the book you now hold in your hands: Alex Alexander, Karla Aronson (BMUG), Mark Bankins (Sound Source Unlimited), Joan Blades (Berkeley Systems), Steve Bobker (Raw Fish Systems), Cameron Crotty, Michael Dolan, Michael J. Fisher, Ben Haller (Stick Software), Lynn Halloran (Now Software), Robin Lane (Microseeds Publishing), Jan Jacobs Johnson (Fifth Generation Systems), Linda Kaplan (Thought I Could), Rick Kaseguma, Ann Lane (Addison-Wesley Publishing),
Arlan Levitan, Bob LeVitus, Alex Louie, Roy M. Lovejoy III (Adept Solutions), Stephen Lovett, Carol Lynn (ExpoTech), Greg Marriott (Apple Computer), Dan Muse, Sean P. Nolan, Stefan G. Pagacik (BCS), Douglas C. Peterson (Anabolic Systems), Frank Price (Mercury Systems), Robert Seaver, Victoria Von Biel (MacUser), and many others whose names I neglected to jot down in my notes. To anyone who I left out or whose name I misspelled (you know who you are), sorry dudes!

Finally, thank you, gentle reader, for purchasing this book. I'll think kindly of you when my royalty checks arrive...
# Table of Contents

*introduction*  
xvii

## Startup

<table>
<thead>
<tr>
<th></th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PICT2Startup</td>
<td>2</td>
</tr>
<tr>
<td>2</td>
<td>ScreenChooser</td>
<td>7</td>
</tr>
<tr>
<td>3</td>
<td>Bongo Bob</td>
<td>16</td>
</tr>
<tr>
<td>4</td>
<td>Lights, Camera, Action!</td>
<td>21</td>
</tr>
<tr>
<td>5</td>
<td>StartupSnd</td>
<td>26</td>
</tr>
<tr>
<td>6</td>
<td>Before Dark</td>
<td>30</td>
</tr>
</tbody>
</table>

## Sound Effects

<table>
<thead>
<tr>
<th></th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>99 Bottles</td>
<td>42</td>
</tr>
<tr>
<td>8</td>
<td>SndControl</td>
<td>47</td>
</tr>
<tr>
<td>9</td>
<td>Makin’ Copies</td>
<td>61</td>
</tr>
</tbody>
</table>

## Random Cool Stuff

<table>
<thead>
<tr>
<th></th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>DarkSide</td>
<td>66</td>
</tr>
<tr>
<td>11</td>
<td>Kilroy</td>
<td>80</td>
</tr>
<tr>
<td>12</td>
<td>SuperApple</td>
<td>84</td>
</tr>
<tr>
<td>13</td>
<td>MICN</td>
<td>89</td>
</tr>
<tr>
<td>14</td>
<td>TailDragger</td>
<td>97</td>
</tr>
<tr>
<td>15</td>
<td>Momentum</td>
<td>100</td>
</tr>
<tr>
<td>16</td>
<td>The Ripper</td>
<td>105</td>
</tr>
<tr>
<td>17</td>
<td>Wacky Lights</td>
<td>108</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Shut Down</td>
<td>18 ShrinkDown</td>
<td>113</td>
</tr>
<tr>
<td></td>
<td>19 Shutdown Fade</td>
<td>114</td>
</tr>
<tr>
<td>Utilities</td>
<td>20 Sound Mover</td>
<td>116</td>
</tr>
<tr>
<td></td>
<td>21 FKEY Master</td>
<td>118</td>
</tr>
<tr>
<td>Exclusive Offers</td>
<td>Now Fun</td>
<td>121</td>
</tr>
<tr>
<td></td>
<td>Chameleon</td>
<td>122</td>
</tr>
<tr>
<td></td>
<td>Companion Disk Offer</td>
<td>124</td>
</tr>
</tbody>
</table>
Introduction

Dumb fun, and plenty of it. That's what I promise to deliver if you buy this book.

Although the Macintosh is an "insanely great" computer, when you get down to the nitty gritty, it's still a computer. And for a lot of people, computers are boring machines that they're forced to use at school or at work. But there's absolutely no reason to put up with a dull Mac. With the programs covered in this book and included on the accompanying disk, it's extremely easy to customize the Mac's operation to reflect your unique style, express your individuality, and make your friends drool with envy.

... using this most excellent book

To uncover the gems included in this book, I spent hundreds of hours combing through user group libraries, on-line databases, and commercial offerings in search of neat programs that fit one strict requirement: they have absolutely no redeeming value other than the totally radical coolness they bestow on Macs and their owners. I've done the hard part, now these programs can be yours for a song (actually, $19.99 retail). Each program is fully documented in its own chapter explaining what the program does, complete with detailed installation instructions, steps for using the program, compatibility notes, and information on contacting the programmers.

This book is organized in the way you would encounter these programs as you use your Mac, with the programs affecting the startup process appearing first. These are followed by stuff that messes with sound effects, a handful of files for creating miscellaneous mayhem, as well as a couple of shutdown items. Finally,
the book ends with two utilities for getting the most out of the other programs on disk.

installing totally rad mac programs

To provide the most bytes for the buck, all of the files included with this book are stored on a single 800K, 3½" disk in a compressed archive. Before you can install the rad programs, you must unstuff the archive. To do so, turn on your Mac and when the Finder's desktop appears, insert the enclosed disk in an empty drive. Double-click the disk icon to open its window, then double-click the Rad.sea icon to launch Stufflt Lite. At the splash screen, click Continue to present a dialog box in which you can specify a name and location for the Totally Rad Programs folder. Pick a hard drive with at least 1.6 Mb of free space, then click Save. An alert box shows the progress as Stufflt Lite unstuffs the files in the folder. If all goes well, click Quit after the alert box announces that the installation was successful. Once the files have been unstuffed, follow the detailed directions in each program's chapter for installing the individual files where they belong on your hard drive.

After installing the programs as described, they have generic icons. If you want your Mac to display the custom icons pictured in this book, you must rebuild your Desktop. The programs are operational as is, but it's a good idea to rebuild the Desktop periodically for preventative maintenance whenever generic icons appear where they shouldn't. To rebuild the Desktop, start your Mac normally, but hold down the Command-Option keys until the Finder asks if you really want to rebuild the Desktop. You do, so click OK. If you have more than one disk, click OK as the Finder asks about rebuilding the Desktop on each. The time it takes to rebuild the Desktop depends on the speed of the drive and the size of the disk. When done, the Finder should no longer show generic icons for any files
that have their own icons. Also, you may notice somewhat faster response time when starting up your Mac or quitting programs. The only drawback to rebuilding your Desktop is that you lose any Comments you may have entered into files’ Get Info windows. Since few people use this feature, it’s usually not a concern.

词语的警告

This book contains optional tips on modifying programs with ResEdit. ResEdit is an extremely powerful utility from Apple Computer that allows you to change various aspects of a program’s resource fork, the area that defines the look and feel of icons, menus, windows, etc. ResEdit is free, but it’s not part of the standard System software distributed by Apple. Since it’s a rather complex utility that can render a file useless with a single keystroke, the best way to get ResEdit is bundled with a book that explains its many features. Always work on a copy of a file, never the original.

With the exception of Before Dark and DarkSide, which require System 7, all of the programs on the enclosed disk have been tested for reliability and compatibility with System 6.0.8 and System 7.1 (if you’re using earlier versions, you should upgrade). I’m reasonably sure that none of the programs contain any viruses or bugs which would in any way damage your Mac or its files. Still, I strongly recommend you always work with a current backup before trying out any new software, especially non-commercial programs.

The programs are provided “as is” and technical support is not available. There’s no guarantee that these programs will work in conjunction with whatever happens to be festering in the inner reaches of your Mac’s hard drive. So use at your own risk and resist the temptation to load up on a mess o’ programs in an attempt to create the coolest Mac in town. Doing so is an invitation to
problems. Instead, use these programs judiciously, adding them one at a time to make sure they function properly on your Mac.

Many of the programs included in this book are system extensions, also called INITs under System 6. These are pieces of code that hook into the main System file, modifying the way it works. As such, system extensions can be extremely powerful. But if they are not well-behaved, system extensions can conflict with one another as well as other programs that have nothing to do with the System. If you’ve ever called a technical support hot-line, I’ll bet you an entire royalty check that at some point you were told that the problem lies not with that firm’s product, but rather, with the infamous and ever-elusive “INIT conflict.” To deal with an INIT conflict, reorder or remove the offending file. The manual way to disable a system extension is to drag it out of the System folder (but not into the Trash), then choose Restart from the Finder’s Special menu. But if you aspire to be a power user, get yourself a utility for managing system extensions. Extensions Manager is a fine freeware utility from Apple Computer, though I personally prefer using Startup Manager from Now Software. Both allow you to reorder and disable system extensions, making it much easier to track down INIT conflicts.

---

**do the right thing**

All of the programs included on the accompanying disk appear with the express written permissions of their authors and publishers. (Programmers being more transient than Bedouins, tracking down everyone was no picnic.) To acquaint you with its quality products, Sound Source Unlimited took a chance by allowing me to include in this book the Star Trek AudioClips. These are part of commercial products that normally sell for more than the price of this book. So enjoy these files in good health, and if you like them,
please patronize this firm (see the special offers at the back of the book). But whatever you do, don’t give away copies of these files to your friends.

All of the other files were written for your enjoyment by individual programmers, some of whom were gracious enough to place the fruits of their efforts in the public domain, meaning you can use and distribute their programs as you see fit. Many programmers retain the copyrights to their work but allow you to distribute their programs as long as you don’t charge anything (hence the nickname freeware). Others, in an attempt to defray the costs of all the pizza and Twinkies they consumed while programming, have released their programs as shareware. That means that you can try before you buy. The success of the shareware concept rests on the honor system, so if you continue to use any shareware program (Before Dark, FKEY Master, ScreenChooser, SndControl, Sound Mover, and StartupSnd) after a reasonable trial period of a week or two, please “do the right thing” and send the author whatever it is they request as a shareware fee, whether it be a few bucks or a measly postcard of your hometown. If you don’t, we’ll send Spike Lee to your house to complain about discrimination while forcing you to watch School Daze and Mo’ Betta Blues ad nauseam.

keep in touch

I love to hear comments about my books from readers like you, so feel free to contact me via electronic-mail or snail-mail (in other words, the U.S. Postal Service). If you’d like a personal reply, please include an SASE and any other inducements you can think of.

Even if you have nothing to say about the book, I would really appreciate it if you would drop me a postcard with your name and address so that I can notify you of general updates, bug fixes, and
other special software and book offers available exclusively to readers such as yourself. Don't worry, I never make my database available to other companies or organizations because I suspect that you don't like junk mail any more than I.

Owen W. Linzmayer
2227 15th Avenue
San Francisco, CA 94116-1824
AppleLink: Owen
America Online: Owen Ink
CompuServe: 71333,3152
The first six programs covered in this book all affect the startup process in one way or another. Normally you must watch the icons of extensions and control panels prance along the bottom of the screen while that dopey “Welcome to Macintosh” greeting stares you in the face. But with PICT2Startup, you can convert any PICT graphics image into a StartupScreen for display during startup. Then use ScreenChooser to keep things interesting by randomizing the display of all your StartupScreens. Instead of displaying pictures, Bongo Bob presents one of over 100 wacky sayings every time you restart the Mac. On the other hand, Lights, Camera, Action! plays animation files during startup, complete with soundtracks if you want. And if you want to impress your friends, StartupSnd plays the Quadra startup chord—or any other sounds—upon startup. Once startup is complete, the Finder's desktop appears with stunning background patterns thanks to Before Dark which allows you to replace the small standard desktop patterns with intricate color patterns up to 256 pixels on a side, much like the commercial program Chameleon.
One of the little-known features of the Mac is its ability to replace the standard "Welcome to Macintosh" startup greeting with a custom picture, be it a bathing beauty, corporate logo, or warning for others to keep their paws off your computer. To take advantage of this feature, you must have some way of saving your pictures in the special StartupScreen file format required by the Mac. That's where PICT2Startup comes in. This tiny application converts images from the common PICT format into the esoteric StartupScreen format. That's all it does. But considering that programmer extraordinaire Chris Derossi whipped up this little baby in twenty minutes on my request, I'm awfully impressed. I know restaurants where it takes longer than that to get water brought to your table.

By the way, if you already own a graphics application that has a StartupScreen (or PICT resource) option in its Save As menu, then
you don't need PICT2Startup. Just save your favorite image as a StartupScreen file, make sure you name it StartupScreen, then drop it into your System folder and restart.

---

**installing pict2startup**

PICT2Startup is an application, and as such doesn't need to go anywhere special on your hard drive. Put it wherever you normally keep applications and utilities.

---

**using PICT2Startup**

PICT2Startup is a no-brainer. Heck, even a mental-midget like former veep J. Danforth Quaalude III could use it without reading these instructions. Launch PICT2Startup by double-clicking its icon. Unlike other programs, which offer lots of choices in menus, PICT2Startup simply displays a standard file selection dialog box. What do you expect? Bells and whistles? Remember, this thing was written in twenty minutes! Got that? Twenty short minutes, ferhevensakes!
Click Desktop or Drive until you locate the volume that contains your PICT graphics, then open the appropriate folders until you can double-click the name of the graphics file you want to convert. Only folders and PICT files are shown. If an image you want doesn't appear, it's probably not in the PICT file format.

A few seconds after you've selected the PICT file to convert, another dialog box appears, asking you to specify the name and location of the StartupScreen.

PICT2Startup defaults to saving the file with the name StartupScreen in the current startup volume's System folder. Under normal conditions, this is what you need to call the file and where you need to put it. If the default is acceptable, click Save; otherwise, enter a different name or change the location.

System 7 users have an alternative way of converting images. Instead of launching PICT2Startup and selecting files via dialog boxes, you can simply "drag-and-drop" in the Finder. Locate the PICT file you want to convert, then drag it on top of the PICT2Startup icon until the latter changes color. When you release the mouse
button, PICT2Startup automatically saves the file with the name *StartupScreen* in the current startup volume's System folder. If a file already exists with the same name, you're asked to confirm whether you want to replace the old image with the new picture.

Here's another great tip for System 7 users. If you don't have a PICT file handy, go to the Finder, then press *⌘*-Shift-3 to activate the Mac's built-in screen capture FKEY. This takes a snapshot of the desktop, which is named *Picture 1* and placed on your startup volume. Then drag the resulting PICT file on top of the PICT2Startup icon. When you turn on your Mac, the desktop appears immediately, giving the impression that everything is ready to go, even though it might normally take quite a long time to load all of your extensions. If your amazed friends inquire, mumble something about "Ultra-high performance RAM disks with zero wait-state boot vectors..."

---

**companion disk goodies**

PICT files can be created with almost every graphics application on the market today, and there are thousands of images available in the public domain; due to space constraints, though, I wasn't able to include any on the program disk for this book. If you have trouble getting your hands on cool graphics, don't sweat it because I've assembled an eclectic collection of PICT files suitable for use as StartupScreens on both color and black-and-white Macs. For details, see the Companion Disk Offer at the back of the book.

---

**compatibility notes**

PICT2Startup works under System 6 and System 7. Because it needs to load the entire PICT file into RAM, the suggested memory requirement is 4Mb. You can launch the program with less memory,
but if it can't fit the PICT file in memory, an alert box appears explaining the problem. Either choose a smaller PICT file, or convert using a Mac with more memory.

 contacting the programmer

PICT2Startup is freeware, copyright © 1992, Chris Derossi. (Address withheld by request.)
As was explained in the previous chapter, the Mac is able to replace the standard "Welcome to Macintosh" startup greeting with a custom picture, provided the picture is in the special StartupScreen file format. While this is pretty neat in and of itself, familiarity breeds contempt. I don't care if you have a StartupScreen of Elle MacPherson (my personal favorite); after a while, you're bound to get sick of looking at the same picture each and every time you turn on the Mac. The good news is that you needn't have a monogamous relationship with your StartupScreen pin-ups anymore. ScreenChooser randomly selects one of many pictures to display, giving you something new to look forward to every time you turn on your
Mac. What's more, it has options for tiling the screen, and installing either these patterns or a full-blown picture as the background for the Finder's desktop.

installing ScreenChooser

To install ScreenChooser under System 6, just drag it into the System folder on your startup volume. Under System 7, double-click the System folder, then drag ScreenChooser into the System folder window (don't just drag it on top of the System folder and let the Finder put it away, otherwise ScreenChooser will load later in the startup process and you won't get to enjoy your StartupScreen as much). Then choose Restart from the Finder's Special menu to complete the installation. (To de-install ScreenChooser, remove it from the System folder and restart.)

using ScreenChooser

Start off by assembling a collection of images created with your favorite graphics application. Since ScreenChooser automatically centers pictures, you can use many different sizes; your pictures needn't fill the entire screen. Also, you aren't restricted to using only the System palette; feel free to use color look-up tables (CLUTs) if they make your picture look better when working with 256 colors or fewer. Using a custom palette is a fairly common trick computer artists use to make their pictures look good when they have only a limited numbers of colors from which to choose. If a picture has a lot of green, for example, rather than rely on the few shades of green in the System palette, a skillful artist replaces unused colors with a wider variety of green. This isn't a problem when
opening pictures with graphics applications, because most such programs use the picture's own palette by default, so everything looks as it was intended. But when you create StartupScreens, normally you must limit yourself to the System palette or risk having your pictures look like psychedelic versions of Warhol paintings created by someone on a bad trip...ah, but I digress. ScreenChooser is smart enough to display pictures during startup with the colors that were in use when the pictures were created. Unless the Monitors control panel is set to Thousands or Millions of colors under System 7, ScreenChooser then dithers the pictures into the System palette when the desktop appears. System 6 users with only 256 colors should dither to the System palette using a graphics application before saving pictures for use with ScreenChooser.

Place all of the images you want to use into a single folder. The files can be named anything you like, but they must be in one of the compatible file formats (PICT, PICT resource, or StartupScreen). Likewise, you can call the folder anything you like, as long as it resides on your startup volume. I recommend giving your pictures descriptive names so you remember what they are, and placing them in a folder called StartupScreens.

There's one other option to consider at this point. Normally, if ScreenChooser picks a small image, it automatically centers the picture in the middle of the screen. However, if that same image has .tile appended to its file name, ScreenChooser tiles the entire screen with copies of the image. For best results, use this option on images of equal height and width; ideally 8, 16, 32, 64, or 128 pixels on a side. Odd sizes can be used, but it takes longer for ScreenChooser to complete the tiling.

Now, before ScreenChooser can do its thing, it must be configured. Open the ScreenChooser control panel by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.
Make sure ScreenChooser is active by turning the master switch on. If you want to temporarily disable ScreenChooser without removing it from your System folder, click Off. It's also a good idea to turn off ScreenChooser before de-installing it permanently, otherwise the General Controls control panel may be unable to display color desktop patterns. If at any point you are confused about what to do, consult the Quick Help box at the bottom of the control panel. For more information, click Help to present a dialog box with detailed explanations of all the options.

If you want the ScreenChooser icon to appear along the bottom of the screen during startup, select the Show Icon at Startup checkbox. If you prefer not cluttering up your beautiful graphics,
deselect the checkbox. This checkbox affects the ScreenChooser icon only; the icons of other control panels and extensions still appear as always.

ScreenChooser has the unique ability to play sound effects associated with individual pictures and tiles. For instance, you may have a picture of your family and a digitized recording of them saying "Hello!" If you want ScreenChooser to play that sound effect every time it displays that picture, you must select the Play Attached Sounds checkbox. Then make sure that the digitized recording is saved as a double-clickable System 7 sound file. Give it the same name as the related picture, then append .snd to the name. In our example, if your picture is called Family Portrait, the sound file should be named Family Portrait.snd and placed in the same folder as the picture. ScreenChooser can handle only a single sound file per image. It's perfectly acceptable to have images without sound files; if ScreenChooser can't find a sound file with the same name as the chosen image, it displays it in silence.

You may want to select the Stretch Images to Screen Size checkbox if your picture isn't the same size as the screen on which it is to be displayed. This tells ScreenChooser to stretch or shrink the picture in memory (not the actual file on disk) so as to fill the entire screen. If the aspect ratio (height by width) of the image is roughly the same as the screen, you may not notice too much distortion. However, sometimes the image looks like it's reflected in a fun-house mirror and may be unacceptable. This option has no effect whatsoever on images with the .tile extension.

Perhaps the coolest thing about ScreenChooser is that, in addition to randomly picking StartupScreens, it can also use the selected picture or tile as the background for the Finder's desktop. Just select the Use Tiling/Picture as Desktop Pattern checkbox and watch in amazement as ScreenChooser replaces the standard, small desktop pattern with a glorious full-screen picture or large, detailed repeating tile. Aside from requiring a little more memory, the only reason I can think of for not using this option is that you may prefer using Before Dark to spruce up the desktop patterns (see Chapter 6).
If you are experiencing difficulties getting your tiles to appear correctly on the Finder’s desktop, try selecting the Save Tilings to System File checkbox. This option inserts the current tile as a pat resource in the System file itself. Since modifying the System file always brings with it the possibility of problems, use this option as a last resort only and as a precaution, make a duplicate of your System file before running ScreenChooser, then drag the copy out of the System folder and onto a floppy disk (if it doesn’t fit on a floppy, just make sure this duplicate System file isn’t left in the System folder or the Mac could get confused the next time you restart). With a backup safe in hand, if something does go wrong while using ScreenChooser, or your System file is corrupted at some later point by unknown forces, you can always replace the bad System file with the fresh copy you just made.

When you have made all your other choices, click Choose Image Folder to present a standard file selection dialog box.

![ScreenChooser window](image)

Locate the StartupScreens folder on your hard disk, and keep clicking Open until you’ve selected one of the graphics residing in the folder. At this point the dialog box disappears because ScreenChooser now knows where to find all of your pictures. Click the close box (⌘-W) to close the ScreenChooser window. An alert box
appears informing you that your changes won’t take effect until you restart.

In that case, choose Restart from the Finder’s Special menu. When ScreenChooser loads, it displays one of your files chosen at random and continues displaying it until the Finder’s desktop appears. If you have selected the Use Tiling/Picture as Desktop Pattern checkbox, it remains visible behind all the other windows and icons on the desktop.

This image is included on the Companion Disk offered at the back of the book.

If another program displays an alert box or other message before the Finder appears, it may obscure your StartupScreen. If this occurs consistently, try making the offending file load before ScreenChooser by inserting a space at the front of the file name, or by using one of the many extension managers widely available in the public domain or in the commercial sector.
Since ScreenChooser picks pictures purely at random, there is always a chance that the same screen will be displayed more than once consecutively. If you keep a lot of StartupScreens in your folder, however, duplication is less likely to happen.

**companion disk goodies**

PICT files can be created with almost every graphics application on the market today, and there are thousands of images available in the public domain, but due to space constraints, I wasn't able to include any on the disk that comes with this book. If you have trouble getting your hands on cool graphics, don't sweat it because I've assembled an eclectic collection of PICT files suitable for use with ScreenChooser. For details, see the Companion Disk Offer at the back of the book.

**compatibility notes**

ScreenChooser works under System 6 and System 7. ScreenChooser doesn't require 32-Bit QuickDraw, but without it, you can display only black-and-white images, and many options are not available. Make sure all file-compression extensions load before ScreenChooser.

**contacting the programmer**

ScreenChooser is shareware and was initially written by Marcio Luis Teixeira when he was only 14 years old. Gimme a break. I didn't even know how to pick my nose at that age, much less program a Mac. If you continue to use ScreenChooser after a reasonable try-out period, please encourage Marcio to continue writing cool programs by sending him the very reasonable shareware fee of $20.
Also, if you enjoy this program, be sure to send Marcio a $5 check for a copy of his shareware disk which contains many other interesting and useful Mac programs. (Please write Shareware Disk Request in the memo field of your check.)

Marcio Luis Teixeira
P.O. Box 271602
Fort Collins, CO 80527-1602
America Online: MarcioT
Bongo Bob is like a dynamic bumper sticker for your Mac, displaying fractured fortunes during the startup process. Of the more than 100 quotes, witticisms, platitudes, and phrases included, I particularly like the motto of all do-it-yourselfers: “If it jams, force it. If it breaks, it needed replacement anyway.” Other words to live by: “A journey of a thousand miles begins with a cash advance.” And, finally, I think it was Dr. Macintosh himself who once proclaimed “Earth has its boundaries, but human stupidity is limitless.” If you don’t like any of the fortunes included, that’s cool, ’cause you can easily change them or add your own.
installing Bongo Bob

To install Bongo Bob, just drag the Bongo Bob extension and the Bongo Bob Data file into the System folder on your startup volume. Under System 7, an alert box appears explaining that the files belong in special places. Click OK and let the Finder put them in the right places. Then choose Restart from the Finder's Special menu to complete the installation. (To de-install Bongo Bob, remove the Bongo Bob extension and data file from the System folder and restart.)

using Bongo Bob

Once installed, Bongo Bob is pretty much a hands-off program. Whenever you turn on your computer or choose Restart from the Finder's Special menu, the Mac begins loading whatever startup documents you have in your System folder. When it gets to Bongo Bob, the Mac resonates with the sound of crashing cymbals as Bongo Bob displays one of over 100 different fortunes.

Welcome to Macintosh.

BONGO BOB
SAYS

You worry too much about your job. Stop it.
You are not paid enough to worry.

Bongo Bob V3.0 • Written by Roby Sherman • Copyright 1992

In deference to sleeping roommates, children, or spouses, Bongo Bob's startup sound doesn't play between the hours of 11:00 p.m. and 11:00 a.m. If it goes off during this quiet period, your Mac's
clock is probably set incorrectly. Change the time in the General Controls control panel.

If you need extra time to read a lengthy fortune, hold down the mouse button to pause Bongo Bob temporarily. If all of the fortunes flash by too quickly, you can either sign up for an Evelynn Wood speed-reading course or make Bongo Bob one of the first extensions to load. Since the fortune remains on-screen until all the other extensions have loaded and the desktop appears, the earlier Bongo Bob loads, the more time you have to read the fortune. You can make Bongo Bob one of the first files to load by inserting a space at the front of the file name, or by using one of the many extension managers widely available in the public domain or in the commercial sector. Bear in mind, however, that if you make Bongo Bob appear early in the startup process, he may stomp on any StartupScreen you may have installed.

If you want to edit the existing fortunes or add your own, open a copy (as a precaution, don't use the original) of the Bongo Bob Data file with TeachText or any other word processor. As you can probably figure out by examining the provided file, the basic rule is that fortunes must be separated from one another by two percent signs (%%) followed by a carriage return. That's all you really need to know, but there are a few other things to keep in mind when formatting your fortunes:

- Fortunes with less than 58 characters per line are displayed using the 12-point Chicago font, whereas longer lines appear as 9-point Geneva. There's no way to specify other fonts, so don't bother.
- Lines with more than 80 characters are truncated, so if you have a long line, break it up with carriage returns so that it displays in its entirety.
- Bongo Bob accommodates multi-line fortunes by stretching its alert box to fit around the fortune, no matter how long. However, don't enter really long fortunes as some
lines may disappear off the bottom of your screen during startup.

- By default, fortunes fewer than five lines long are automatically centered when displayed by Bongo Bob, and fortunes greater than four lines long are left justified.

- To force a longer fortune to appear centered, insert $C as the first two characters in the first line of the fortune. You need not place this formatting code on its own line nor separate it from the first word or character of your fortune.

- To make Bongo Bob display the fortune and wait for a mouse click before proceeding, insert $M at the beginning of the first line of the fortune. The $M and $C formatting codes can be combined if you want to center a fortune and wait for a mouse click. Since Bongo Bob halts the startup process indefinitely waiting for a mouse click, don't use the $M code if you need the Mac to be able to start up unattended.

Once you are finished making changes, choose Save As from your word processor's File menu and select the Text, Text Only, or ASCII file format option (commonly hidden in pop-up menus). Make sure you name the file Bongo Bob Data and that you save it in the System folder. Changing the Bongo Bob Data file may screw up Bongo Bob's fortune pointer, causing it to display an incomplete fortune the next time it loads. Don't panic. Bongo Bob automatically synchronizes on the next go around.

---

ResEdit tip

To eliminate or change the clashing cymbals sound effect, modify the snd resource (ID 128).
**compatibility notes**

Bongo Bob requires System 6.0.5 or higher.

**contacting the programmer**

Bongo Bob is photoware, so if you enjoy it, all you need to do is send a picture of yourself to Roby Sherman, along with any deep thoughts you'd like to share. Who knows, if you say something witty enough, it just might make it into the next version of Bongo Bob!

If you want a disk packed with over 7,000 fortunes (including Blonde Jokes, Jokes for Children, and Tasteless Jokes) plus an application version of Bongo Bob, send $5 (U.S. funds only) to Roby along with your name and address. Roby cautions that he is not responsible for the contents of Bongo Bob's fortune files and that some material may be considered offensive.

Roby Sherman  
Interealm  
P.O. Box 110177  
Aurora, CO 80042-0177  
America Online: Interealm
Heavy traffic, no place to park, earthquake, flood, taxes due, in-laws visiting, overdrawn, missed the bus, just got invaded.... Sometimes when you turn on your Mac at the beginning of the day, life seems to have lost its meaning. Just then the sound of birds surrounds you and your eyes notice a beautiful sunrise on the screen. Relaxing on the bank of a small serene lake, fresh spring water washes at your feet; you begin to unwind. Your mind clears and when the music fades, your sanity returns. Wow, that was great! Was it some awesome Zen moment? Not bloody likely. It's Lights, Camera, Action! (LCA! for short).

All of the programs discussed so far relate to replacing the Welcome to Macintosh greeting with a static StartupScreen or message. If you think that's cool, you're going to be blown away by LCA! because now you can play startup animations complete with sounds!
installing Lights, Camera, Action!

To install Lights, Camera, Action!, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Control Panels folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation. (To de-install LCA!, remove it from the System folder and restart.)

using Lights, Camera, Action!

Before LCA! can win friends and influence people, it must be configured. Open the Lights, Camera, Action! control panel by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.
Click Choose File to present a standard file selection dialog box.

Click Desktop or Drive until you locate the volume that contains your animation files, then open the appropriate folders until you can double-click the name of the animation file you want to play upon startup. Only folders, PICS animations, QuickTime movies, and PICT files are shown. If the file you want doesn't appear, it's probably not in the correct file format.

After you have chosen a file, check that it's the right one by clicking Preview to play the animation or view the image. Just click the mouse or press any key to stop the preview. If it's not the right file, click Choose File again and try another.

Click Add Sound to present a standard file selection dialog box if your PICS animation (sorry folks, this feature doesn't work with QuickTime or PICT files) lacks the full multimedia experience (i.e., no sound). Click Desktop or Drive until you locate the volume that contains your sound files, then open the appropriate folders until you can double-click the name of the sound file you want to play with your PICS animation. Only double-clickable System 7 sound files (their icons look like documents with a speaker) are shown. If a sound you want doesn't appear, it's probably not in the correct file format. Once you select the sound file, its sound resource is
added into the PICS animation file. That's why you get an error message if you click Add Sound before choosing an animation file. After all, LCA! doesn't know where to put it, though I'm sure you might have some helpful suggestions.

There are three optional controls that allow you to modify how the startup animation is played:

- Change the volume by clicking the arrows to the right of the speaker icon. Disturb your neighbors (Real Loud) or keep the peace (Almost Silent)—the choice is yours.
- Change the animation's playing speed by clicking the arrows to the right of the jogger icon. Animations can run anywhere from an Amtrak-like crawl (Very Slow) to blazingly fast (Top Speed).
- Change the number of times the animation plays by clicking the arrows to the right of the projector icon. You can set it to play one, two, three, or four times. Or, let it repeat endlessly until you click the mouse button or press a key.

If you can't figure out what the Help button does, you're definitely not riding the edge. After you've made all the adjustments necessary, choose Restart from the Finder's Special menu to see LCA! in action. When the LCA! control panel loads, your animation plays as many times as specified, complete with sounds if available, and then the normal startup procedure continues.

---

**ResEdit tip**

LCA! plays PICS files one PICT resource at a time, starting with ID 128 and increasing sequentially. If you have added sounds to your PICS file, LCA! plays the sound resource with the same number as the PICT currently being displayed. You can use ResEdit to add more sounds to your animation if you wish.
companion disk goodies

As noted, LCA! requires PICS animations, QuickTime movies, and PICT files, which can be created with many 3-D and animation applications on the market today, and there are hundreds of animations available in the public domain. But due to space constraints, I wasn't able to include any on the disk that comes with this book. If you have trouble getting your hands on appropriate animations, don't worry, be happy. I've assembled a handful of files suitable for use with LCA! on both color and black-and-white Macs. For details, see the Companion Disk Offer at the back of the book.

compatibility notes

LCA! requires System 6.0.3 or higher. If you want to play QuickTime animations, you also need the QuickTime extension plus 32-Bit QuickDraw, which is present in System 7 and is available as an extension for any color-capable Mac running System 6.0.7 or later.

contacting the programmer

Although Lights, Camera, Action! is freeware, it remains copyright © 1990–1992 by Robert S. Mah. However, if you really, really like it, Robert would appreciate a few bucks, a postcard, a donut, or something. Also, if you experience any anomalies or have a suggestion or two for improvement, please send them along.

Robert S. Mah
309 West 30th Street, #6C
New York, NY 10001-2773
America Online: RMah
CompuServe: 76437,320
Internet: RMah@Panix.com
StartupSnd is a very simple program that plays sounds—digitized voices, musical notes, special effects, you name it—during the start-up process. It dutifullly plays whatever sounds you’ve installed inside the file, without regard for your personal taste (or lack thereof). So that you can hear how it works right away, StartupSnd comes preloaded with the sound of a Mac Quadra starting up. I love watching the faces of power users when they hear a lowly Mac Plus sing like a Quadra at startup! If you haven’t heard it already, the Quadra has a rich startup chord that makes the startup sound on old Macs seem downright pathetic. But the Quadra’s Pentagon-style pricetag is a wee bit too steep if all you want to do is impress your friends with a cool startup sound.
installing StartupSnd

To install StartupSnd, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation. (To de-install StartupSnd, remove it from the System folder and restart.)

using StartupSnd

Once installed, StartupSnd requires no user interaction. Whenever you turn on your computer, or choose Restart from the Finder's Special menu, the Mac begins loading whatever startup documents you have in your System folder. When it gets to StartupSnd, the Mac resonates with the sound of whatever sound resources are installed in the StartupSnd file. Because your Mac's original startup sound is burned into ROM, StartupSnd does not replace or change it in any way.

If you don't want StartupSnd to play at startup, you have several options. First, you can permanently disable it by removing it from your System folder altogether. Or you can simply use the Sound control panel to set the Speaker Volume to zero, in which case StartupSnd does nothing at all upon startup, and the menu bar flashes whenever a beep would normally be heard. Finally, StartupSnd can be temporarily disabled by holding down the Caps Lock key upon startup. This is probably the best method to use because it doesn't require you to change the Sound control panel setting.

It should be noted that System 7 users don't really need StartupSnd. Instead, just drag double-clickable sound files (their icons look like documents with a speaker) or their aliases into the Startup Items folder inside the System folder. When the Finder appears, it plays in alphabetical order whatever sound files it finds in the Startup Items folder. To stop the Finder from playing the sounds and
launching the applications in the Startup Items folder, hold down the Shift key when the titles in the Finder's menu bar first appear.

---

**ResEdit tip**

As I mentioned before, StartupSnd comes with the Quadra startup chord already installed as a snd resource (ID 14109). If you want to remove this, or add your own sounds, you could use ResEdit, but I recommend using Sound Mover, described in Program 20.

---

**companion disk goodies**

You may be wondering how to get your greedy little paws on other cool sounds. If your Mac comes with a built-in microphone jack, you've got everything you need (see your Mac's documentation for instructions on using the Sound control panel). If you lack a microphone, consider buying Macromedia's MacRecorder. This little device attaches to a serial port and can digitize and edit sounds. If you don't want to bother recording your own sounds, you can obtain sounds from user group libraries, on-line information systems, and commercial public domain distributors.

If cool sounds elude you, no problem. I've assembled an eclectic collection of sounds suitable for use as with StartupSnd, Snd-Control, and Sound Mover. For details, see the Companion Disk Offer at the back of the book.

---

**compatibility notes**

StartupSnd works under System 6 and System 7.
...contacting the programmer...

StartupSnd is a part of the shareware Sound Manager Package. For $25, you get the latest versions of StartupSnd, Sound Mover, Snd-Control, and IBeep2, plus a printed manual sent to any part of the world via air mail. The programs are not in the public domain, but rather, are copyright © 1987–1992, Riccardo Ettore, with portions also copyright © 1986, Think Technologies.

Riccardo Ettore
67 Rue De La Limite
1970 Wezembeck-Oppem
Brussels, Belgium
Phone: 32-2-7679217 (never after 3 PM EST)
America Online: R.Ettore
AppleLink: BEL0128
CompuServe: 72277,1344
GENie: R.Ettore1
One way of customizing your Mac is to open the General Controls control panel and play with the desktop pattern, which is always present behind all of your icons and windows. Problem is, the clumsy "fat bits" editor provided makes it darn near impossible to create any decent-looking patterns in the tiny box 8 pixels (picture elements, or dots) on a side, and Apple's built-in patterns are either more boring than a congressional debate on C-SPAN or uglier than clothing from the 1970s. Before Dark is the shareware version of Chameleon from Logical Solutions. Both applications replace the Finder's default desktop patterns with incredibly cool ones as large as 256 pixels square and containing up to 256 colors. Before Dark comes with 30 complex background patterns with intricate repeating designs. What's more, the program is System 7 savvy and includes such amenities as Balloon Help and the ability to import patterns from almost any source.
installing Before Dark

Before Dark is an application, and as such doesn't need to go anywhere special on your hard drive. Put it wherever you normally keep applications and utilities.

using Before Dark

Launch Before Dark by double-clicking its icon. If you have not yet registered your copy of Before Dark, a dialog box appears asking if you want to register now.

If you've sent in your shareware fee, click Register to present a dialog box in which you can enter the code provided by programmer Craig Marciniak upon receipt of your $10. This prevents the annoying dialog box from ever appearing again. If you want to check out the program before paying the shareware fee, click Not Now to present the main Before Dark window.
The small preview in the left-hand side of the Before Dark window shows one of 30 high-quality desktop patterns created by several professional graphic designers. To see the other patterns that are included with Before Dark, click the small arrow buttons or press the arrow keys to cycle left or right. Notice that each time you switch patterns, the text box to the right also updates. This displays a comment such as the name of the pattern or its creator. To modify this comment, click in the text field and a dialog box appears.
Enter any comment you like, then click Save to record your comment, or click Cancel to ignore the change. Whatever changes you make are saved to disk when you choose Quit (⌘-Q) from the File menu.

If you want to see what a particular pattern looks like on the desktop, click Apply (⌘-A) or click directly on the pattern in the preview area. This temporarily changes the desktop pattern to the pattern displayed in the preview area.

If you like what you see, make the change permanent by clicking Install or choosing Install Pattern as Startup Item (⌘-S) from the File menu. This places a small application called ApplyPattern into the Startup Items folder inside your System folder. At the end of the startup process, just after the Finder’s desktop appears, all of the applications and documents in the Startup Items folder are launched or opened in alphabetical order. When the ApplyPattern
application launches, it instantly covers the desktop with the pattern you selected. This doesn't affect the System file at all. What's more, the change is easily undone. Hold down the Shift key during startup to prevent the Startup Items from launching, or choose Remove Startup Pattern from Before Dark's File menu to delete the ApplyPattern file, causing the standard desktop pattern to appear the next time you restart. You can see what the current pattern looks like by choosing Show Startup Pattern from the File menu.

If you want to consider other patterns, continue previewing them until you find one you want to install. Or choose Apply Current System Pattern from the File menu to revert back to whatever was previously installed in the System file as the desktop pattern.

With older versions of Before Dark and similar desktop pattern editors, once you install a pattern greater than 8x8 pixels, the color patterns in Apple's General Controls control panel disappear, and you're left with black and white patterns only.
If you want to restore the color options to the General Controls control panel, choose Virginize System from Before Dark's File menu. This change need only be done once, and only if you have used a program that actually alters the pattern resource in the System file.

On the off chance that you don't find anything you like among the 30 patterns included, click Import to present a standard file selection dialog box.

Click Desktop or Drive until you locate the volume which contains the file with the ppat (PixelPattern) resource you desire, then open the appropriate folders until you can double-click the name of the file you want. The file you select must contain at least one valid ppat resource. Because they have a proprietary data structure, you can't import patterns that work with Thought I Could's Wallpaper, a commercial program that competes with Chameleon. Once you have opened a file with a ppat resource, a dialog box appears from which you can select the pattern you desire.
Click the left and right arrow buttons to cycle through the available patterns in the open file, then click Import if you want to permanently add the currently displayed pattern to those already contained in the Before Dark application. If you know you want all of the patterns included in the file, click Import All. When you are finished importing patterns, click Done.

Each pattern you add to Before Dark makes the application somewhat larger. If the file ever takes up too much disk space, preview a pattern that you don't like, then choose Delete Pattern from the File menu. An alert box appears asking you to confirm whether you really want to permanently remove the selected pattern from the application. Click Yes to kill it, or No if you change your mind.
Before Dark

ResEdit tip

If you create your own ppat resources in ResEdit, choose Get Resource Info (⌘-I) from the Resource menu, and mark only the System Heap and Purgeable attribute checkboxes.

companions disk goodies

The ppat resources used by Before Dark are easily created with Apple Computer's ResEdit utility, and there are thousands of patterns available in the public domain. But due to space constraints, I wasn't able to include any extra patterns on the disk that comes with this book. If you want more than the 30 patterns that are built into Before Dark, you're in luck, because I've assembled a wild batch of patterns suitable for importing into Before Dark. For details, see the Companion Disk Offer at the back of the book.

compatibility notes

Before Dark requires System 7 and 32-Bit QuickDraw (works best with 8-bit or greater video, but can be used on black-and-white monitors, too). If you want the ability to modify your desktop patterns under System 6, I recommend you purchase Thought I Could's Wallpaper, which also includes a powerful pattern editor and an extensive collection of beautiful patterns.

contacting the programmer

Before Dark is copyright © 1993, Craig Marciniak. The shareware fee is $10. Craig encourages you to share your comments, bug reports, chit-chat, and money. As mentioned earlier, Before Dark
has a commercial counterpart called Chameleon which features an improved interface, powerful pattern editor, and many beautiful patterns up to 256 pixels square. See the exclusive offer in the back of this book for information on purchasing Chameleon at a substantial discount.

Craig Marciniak
151 83rd Avenue N.E., #305
Fridley, MN 55432-6848
America Online: TemplarDev
AppleLink: L.Solutions
Part II: Sound Effects

One of the features that really sets the Mac apart from other kinds of computers is its powerful sound generating capability. In this section I examine a trio of programs that show off how the Mac can make beautiful music and play digitized sound effects with the greatest of ease. This capability is exploited in the most frivolous manner by 99 Bottles, a little application which sings "99 Bottles of Beer on the Wall" at various speeds with any number of bottles of beer. SndControl, on the other hand, is somewhat more useful because it plays sounds corresponding to various events. I've included a dozen authorized Star Trek sound effects so you can have Spock say "Reset" each time you choose Restart from the Finder's Special menu, for example. Finally, Makin' Copies is a take-off on the hilarious Saturday Night Live skit starring Rob Schneider. Just install it, then every time you duplicate files, disks, or folders, the Mac announces that you're "Makin' copies!"
What could be more annoying than being stuffed in your father's gas-guzzling Oldsmobile on a cross-country trip during which you're forced to sing "99 Bottles of Beer on the Wall" with a bunch of soused college fratmates? Seriously folks, nobody in their right mind ever finished this "song" (and I use the term in the loosest sense of the word), but since computers enjoy doing mindless repetition, it was inevitable that someone—in this case, the truly demented programmer Jay Geagan—would computerize this arduous task. Not only does 99 Bottles make your Mac sing one of the world's most irritating ditties (granted, the lyrics are just a little less repetitive than the typical pabulum-puking pop song by R.E.M.), it can be modified to count down from any number of bottles of beer up to 10 quadrillion!
installing 99 Bottles

99 Bottles is an application, and as such doesn’t need to go anywhere special on your hard drive. Put it wherever you normally keep applications and utilities.

using 99 Bottles

Launch 99 Bottles by double-clicking its icon. It immediately opens and goes into a computerized rendition of the song “99 Bottles of Beer on the Wall.”

![99 Bottles of Beer](image)

Since it works in the background under MultiFinder or System 7, you can switch to another application and 99 Bottles keeps a singin’ til there ain’t no mo’ bottles of beer on dat dar wall.

As if that wasn’t annoying enough, choose New Song (⌘-N) from the Menu menu to start a duet. Do it again and get a round going. On a Mac with an Apple Sound Chip (Mac II or higher) and System 6.0.6 or higher, you can theoretically have up to 30 songs going at one time, with the Sound Manager attempting to mix them all together. The actual number of songs that can be played simultaneously depends on the horsepower of your Mac. Choosing More Sounds (⌘-M) from the Menu menu tells the Macintosh not to interpolate sounds, resulting in less work for the Sound Manager, (allowing it to play more sounds simultaneously). The trade-off is that the sound is grainier than if you had chosen Smooth Sounds (⌘-S) from the Menu menu.
If you're of the opinion that 99 bottles of beer just aren't enough to pass around (who knows, perhaps you went to a wicked big party school like Boston University), click on the bottles left box (or press ⌘-B) to present a dialog box in which you can enter any number of bottles, from 0 to 10 quadrillion. A big number gets on your nerves real quick, but not before you laugh your butt off when the Mac announces that there's only "Nine quadrillion, nine hundred ninety-nine trillion, nine hundred ninety-nine billion, nine hundred ninety-nine million, nine hundred ninety-nine thousand, nine hundred ninety-nine bottles of beer on the wall."

Likewise, click on the pitch bend box (or press ⌘-P) to present a dialog box in which you can enter a value from -24 to 24. A unit of pitch bend equals one musical half-step, therefore there are 12 units of pitch bend per octave, giving a ±2 octave range. For the musically impaired, that means negative numbers make the Mac imitate James Earl Jones on "ludes, and positive numbers sound like a Chipmunk auctioneer on speed. Changes to the pitch bend take effect once the current stanza is complete.
pitch bend:
is: 0

Enter a new value: 0

Cancel OK

ResEdit tip

99 Bottles “sings” by stringing together the digitized roots of the words that form the lyrics. If you have way too much time on your hands and a Mac with sound input capabilities, try modifying the snd resources with your own voice.

compatibility notes

99 Bottles requires Sound Manager, which is present in System 6.0.6 and higher, including System 7. Apparently there is a bug in some versions of Sound Manager, which occasionally sends it screaming off into never-never-RAM to look for sound data. As a result, every once in a very blue moon, 99 Bottles starts playing random noises from random memory locations (in RAM or even ROM), making the Mac sound like it’s on its last legs. If you can imagine Pink Floyd scratching blackboards at a road construction site with some AM radios loudly playing frequencies between stations during a thunderstorm, then you’ve got the general idea. If it happens to you, choose Quit (命令-Q) from the Menu menu, then relaunch 99 Bottles and try again.
Contacting the programmer

99 Bottles is freeware. If you like it, don't send money. Save it for your medication, because you're obviously sick and in need of immediate psychiatric attention.

Jay Geagan
Pad-Parrot Productions
3500 Granada Avenue, #383
Santa Clara, CA 95051-3355
America Online: J Geagan
AppleLink: J Geagan
CompuServe: 71311,301
One relatively unknown feature introduced in System 6.0.4 is the Mac's ability to play sounds corresponding to various events such as opening windows, deleting files, and ejecting disks. All you need to take advantage of this feature is a shareware program such as SndControl. This baby helps your Mac break the sound barrier by allowing it to complain when you insert a bad disk, insult your momma when you do something stupid, or say goodnight when you shut down. Instead of just the simple beep you've grown to know and hate, SndControl allows you to associate any sound you want to more than 30 distinct actions or events. I've included a dozen sound effects from the classic Star Trek television series, and you can use your own sounds to give your Mac a complete attitude transplant.
installing SndControl

To install SndControl, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Control Panels folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation. (SndControl is designed to replace Apple’s Sound control panel. Unless you use the Sound control panel to record sounds with the audio input now standard on many Mac models, you can remove it from your System folder. Or leave it be if you wish; the two control panels don’t conflict.)

Installing SndControl as just described is all you must do, but the program is more fun if you take a few extra steps to install a full complement of sound files. SndControl looks for sounds (that is, resources of type snd) inside three different places: the System file, a suitcase named snd located inside the System folder, plus suitcases or other files opened with Suitcase II, Master Juggler, or a similar utility. Instead of bloating the System file by installing sounds directly into it, I recommend you use Sound Mover to create a resource file called snd, then copy all your sounds into this file (see Chapter 20 for details). When you’re done, save the snd file in the System folder so SndControl can locate and open it during startup.

To get you started, the enclosed disk contains a dozen Star Trek sounds, courtesy of Sound Source Unlimited, the firm that holds an exclusive license to sell samples from the original television series. Unlike the low-quality recordings available illegally from on-line services, these authorized sound effects were digitally recorded from the soundtrack masters, then saved as data files for playback on the Mac. The dozen sounds included in this book are a representative sample of the hundreds of AudioClips available commercially from Sound Source Unlimited.

To de-install SndControl permanently, remove it from the System folder and restart. If you want to temporarily disable SndControl,
select the Don't load checkbox in the SndControl control panel and then choose Restart from the Finder's Special menu.

**** using SndControl

Before your Mac can make music, blurt out obscenities, and sing songs, you need to tell SndControl which actions trigger what sounds. Open the SndControl control panel by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.
The SndControl control panel may appear confusing at first, but actually it's easy to use once you understand the basic features. The top portion of the control panel is dedicated to the specific actions, sounds, and volume controls. The bottom portion determines the overall operation of SndControl. The best way to explain how to use both sections is to walk you through the process of assigning a sound to an action. Basically, to assign a sound to an action, select an action by clicking its radio button, choose a sound for that action by clicking in the scroll box, then set the volume for that sound by adjusting the slider on the right.

The first time you open SndControl (or any time you trash its preferences file), the Beep action is set to Simple Beep (actually, to the snd resource with ID 1, assuming there is one) and all other actions are set to No sound (i.e. silence). Including Beep, there are currently more than 30 actions to which SndControl can assign sounds (more actions may be added in the future, so be sure to register). The actions are listed in groups on the left-hand side of the control panel next to the radio buttons. Click the arrows at the top of the list to cycle through the groups so that you can see all of the different actions:

<table>
<thead>
<tr>
<th>Action</th>
<th>Restart</th>
<th>Shift On</th>
<th>Chime Bell</th>
<th>Copy Done</th>
<th>Alarm</th>
<th>ZoomIn</th>
<th>ZoomOut</th>
<th>Resize-Window</th>
<th>Close-Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beep</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk Eject</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk Insert</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bad Disk</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Disk Return</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Empty Trash</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fill Trash</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Startup</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Action</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Action</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Action</th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

The actions are listed in groups on the left-hand side of the control panel next to the radio buttons. Click the arrows at the top of the list to cycle through the groups so that you can see all of the different actions.
To my way of thinking, most of the actions are pretty much self-explanatory, but there are a few items for which some additional information wouldn't hurt:

- **Empty Trash:** Whether you choose Empty Trash from the Finder's Special menu or you drag all the files out of the Trash, SndControl plays whatever sound you assign to the Empty Trash action. So don't be alarmed if the Mac announces that "I took out the trash, master" if you simply dragged the files to safety by removing them from the Trash window. Rest assured that nothing has been erased.

- **Startup:** Plays a sound whenever the Mac completes the startup process. To avoid playing the Startup sound, hold down the Caps Lock key during startup until you see an icon that says Shh and CAPS! This doesn't affect the StartupSnd extension covered in Chapter 5.

- **Chimes:** You can select a sound to be played on the hour (Chime:00), quarter past (Chime:15), half past (Chime:30), and quarter to (Chime:45). You may also assign a sound to play the number of hours on the hour (Chime Bell). Chime sounds play synchronously, which means you can't do anything with the Mac until they are finished playing. For this reason, I recommend a very short sound for the Chimes. Note that pressing the Option key allows the current sound to finish playing, and stops all further sounds until released. Useful if it's noon and you can't be bothered listening to twelve synchronous dongls!

- **PhraseTalk:** Plays a sound whenever a given word or phrase is typed. Click PhraseTalk, and in the text field that appears below the scroll box, enter the word or
phrase SndControl should look for, making sure you specify the correct capitalization. You may change the phrase and its associated sound at any time; there's no need to restart your Mac. Then whenever you type the phrase in a word processor or what-have-you, SndControl plays the specified sound.

- **IdleTalk**: Plays a sound whenever a predefined period of inactivity (no keystrokes or mouse movements) has elapsed. Click the IdleTalk radio button, and arrows appear to the right of the IdleTime text field beneath the scroll box. Click the arrows to change the number of minutes the Mac should wait for before hurling insults at you. Digitized wisecracks such as "Get back to work, you lazy bum!" can be hilarious because they seem appropriate at the time they're uttered. It's kind of like having Baseline Publishing's Talking Moose, but without the cute animation of the cartoon characters.

- **PB**: The actions that start off with the letters PB are specific to the Mac Portable and PowerBook computers, such as plugging and unplugging the power cord, as well as going into and waking up from the Sleep mode.

- **Copy Done**: Plays a sound when the Finder finishes duplicating files. Click Copy Done and in the text field that appears below the scroll box, enter the word that SndControl should look for, making sure you specify the correct capitalization. If your System is not in English, you may change the word Copy to reflect the name of the alert box in your own language. Also note that under System 6, the plain ol' letter D does the trick.
- **Alarm**: Plays a sound whenever Apple's Alarm Clock desk accessory goes off. If you don't use the Alarm Clock DA, don't bother setting up a sound for this action.

- **CloseWindow**: Plays a sound whenever a window closes. If you enter a window title in the text field that appears when you click CloseWindow, SndControl plays a sound only when that particular window closes.

Once you see an action to which you want to assign a sound, click its radio button. If a sound is already assigned to that action, it plays automatically, the scroll box displays its name, and the size (in bytes) of the sound or suitcase appears below the scroll box for informational purposes only. To assign a new or different sound, select one from the scroll box and everything updates as the sound plays. The scroll box displays only those sounds contained in the System file, those in a suitcase file named `snd` located inside the System folder, and those in suitcases or other files opened with Suitcase II, Master Juggler, or a similar utility. If you don't want the Mac to play anything for a particular action, click No sound at the top of the sounds scroll box or press Esc.

When assigning sounds, consider the circumstances under which the action occurs so that the sound you use is appropriate. For instance, the Beep action may occur when you click the wrong item on a list, as well as when your telecommunication program finishes downloading a file. Therefore it makes sense to assign a short, nonspecific sound like a horn rather than the Simpson's theme song. On the other hand, the PB Sleep action only happens when the PowerBook goes into Sleep mode, so it makes sense to assign the sound of a lullaby or snoring.

Having the same sound played every time a given action occurs soon becomes very boring and even irritating at times. But with SndControl, actions can be assigned randomly selected sounds.
Select the Randomize checkbox and the full list of sounds is replaced by a list of sound suitcases present in your System folder. If you choose Random from System, a sound is picked from the sounds in the System file and all open suitcases. Selecting a suitcase tells SndControl to pick a sound from that particular suitcase only. This way, you can create thematic suitcases to be assigned to a particular action (such as one suitcase with sounds of various bodily functions for Disk Eject, and another suitcase with curses and swears for Bad Disk). Name these sound suitcases whatever you like; just make sure they are stored in the System folder.

By default, the volume for all sounds matches the setting for Beep, which itself starts off the same as the General control panel (under System 6) or the Sound control panel (under System 7). Changing the volume for Beep using SndControl is equivalent to changing the General or Sound control panels' volume setting. For this reason, the Beep volume is called the control panel volume (CP volume for short).

Each action-sound pair can have its own unique volume setting, so your Restart sound can be as quiet as a church mouse even if your Bad Disk sound is as loud as Reverend Al Sharpton. To change the volume, click the slider and drag it to a new setting from 0 to 7 (if zero, the menu bar flashes whenever a sound would normally be played). To force the sound to be played at the same volume as the Beep action, select the Use CP volume checkbox. If you subsequently adjust the volume with the slider, the Use CP volume checkbox is automatically deselected. Also note that whenever the Beep volume is set to zero, the Mac remains silent no matter the settings of the various sounds. Finally, to temporarily silence the Mac, hold down the Option key just before and during the action that would trigger the sound (e.g. holding Option down as you choose Empty Trash from the Finder's Special menu prevents that sound from playing).
Well, that covers the basics of using SndControl: pick an action, select a sound, set its volume. The choices you make are saved in a file called SndControlPrefs, stored in the Preferences folder within your System folder. In addition to the basic operation just described, there are a number of other options and features you should know about to fully enjoy SndControl.

**Keep in RAM:** By default, sounds are fetched from disk when needed and purged from memory immediately after being played. While this usually works well, sometimes there is a noticeable delay as a sound is read from disk. If the delay bothers you, select the Keep in RAM checkbox to retain the selected sound in memory after it is initially read from disk. Upon subsequent uses of the sound, it is played from memory with no delay. Note, however, that if there is insufficient memory any time a new sound needs to be loaded from disk, the Mac remains silent. Also, when the Randomize checkbox is selected, the Keep in RAM checkbox is dimmed since it makes no sense to keep a randomly selected sound in memory.

**Show Icon:** Select the Show Icon checkbox if you want the SndControl icon displayed during startup; deselect the checkbox if you prefer keeping your StartupScreens free from as much clutter as possible. If this checkbox is selected, you won't see the icons that tell you if the Startup sound has been disabled or if SndControl has been turned off temporarily. No great loss in my opinion.

**Exclude:** Normally, SndControl is active in the Finder as well as all other applications. However, you may want to disable SndControl while you're working in applications such as HyperCard, Sound Mover, SoundEdit, and any other program that makes heavy use of sound. To do so, click Exclude to present a dialog box.
If you experience problems with a particular application, add it to this list to turn SndControl off while it's active.

This dialog box shows all the applications for which SndControl should be temporarily disabled. To exclude an application, click Add to present a standard file selection dialog box.
Click Desktop or Drive until you locate the volume that contains your applications, then open the appropriate folders until you can double-click the name of the application you want to exclude. The chosen application is added to the list that SndControl excludes from its domain. If you make a mistake, or change your mind, click a name in the scroll box, then click Remove. When you are finished excluding applications, click Done.

**LaunchSnd:** SndControl can play a sound whenever a certain application is launched if you take advantage of a secret feature called LaunchSnd. Use Sound Mover to copy a sound resource into the application itself (to open an application in Sound Mover, hold down the Option key as you click Open) and rename the sound LaunchSnd using the Edit pop-up menu. That's it. SndControl plays the sound every time you launch that application unless you hold down the Option key while you launch, turn the volume down to zero, rename the sound to something other than LaunchSnd, or remove the sound from the application altogether.

Under MultiFinder it's recommended that you increase the amount of memory allotted to the application by an amount roughly equal to the size of the sound. See the following section for details.

**MultiFinder:** When using MultiFinder under System 6, each application (including the Finder itself) comes with a suggested memory setting. If you notice that some sounds don't play while running a particular application, that's a sure sign that you should increase that application's memory setting. To do this, click the application's icon once, choose Get Info (⌘-I) from the File menu, then enter a larger number in the Current size text box in
the lower right of the Get Info window. By the way, it's a good idea to increase the Finder's memory setting by 100K or so, thereby giving it more breathing space and allowing even larger sounds to be played.

**companion disk goodies**

You may be wondering how to get your greedy little paws on other cool sounds. If your Mac comes with a built-in microphone jack, you've got everything you need (see your Mac’s documentation for instructions on using the Sound control panel). If you lack a microphone, consider buying Macromedia's MacRecorder. This little device attaches to a serial port and can digitize and edit sounds. If you don't want to bother recording your own sounds, you can obtain sounds from user group libraries, on-line information systems, and commercial public domain distributors.

If cool sounds elude you, no problem. I've assembled an eclectic collection of sounds suitable for use with StartupSnd, SndControl, and Sound Mover. For details, see the Companion Disk Offer at the back of the book.

**compatibility notes**

SndControl requires System 6.0.4 or higher, including System 7. If you attempt to use it under an older system, its startup icon is crossed out. While compatible with most programs commonly available, you should be aware of the following cautions regarding the loading order necessary for proper operation:

- Suitcase must load before SndControl if you've selected a Startup sound that is contained in a suitcase compressed with Font & Sound Valet.
- Multitalk2 must load before SndControl, otherwise the Mac crashes when you put anything in the Trash.
- SmartQuotes version 1.2 must load after SndControl or you risk crashes on a Mac SE.
- CEToolbox must load before SndControl, otherwise Restart and Shutdown will be silent.

... contacting the programmer

SndControl is a part of the shareware Sound Manager Package. For $25, you get the latest versions of StartupSnd, Sound Mover, SndControl, and IBeep2, plus a printed manual sent to any part of the world via air mail. The programs are not in the public domain, but rather are copyright © 1987–1994, Riccardo Ettore, with portions also copyright © 1986, Think Technologies.

If you enjoy using SndControl, you may be interested to know that it has a bigger brother called FunSounds, part of Now Software's Now Fun! collection of...well, fun software modules. FunSounds handles more events, sports an improved user interface, and requires System 7. See the exclusive offer in the back of this book for information on ordering Now Fun! at a substantial discount.

Riccardo Ettore  
67 Rue De La Limite  
1970 Wezembeek-Oppem  
Brussels, Belgium  
Phone: 32-2-7679217 (never after 3 PM EST)  
America Online: R.Ettore  
AppleLink: BEL0128  
CompuServe: 72277,1344  
GEnie: R.Ettore1
The Star Trek recordings in the AudioClips folder are not part of SndControl, but rather are included courtesy of Sound Source Unlimited. The recordings are copyright © 1992, Paramount Pictures. Star Trek is a registered trademark of Paramount Pictures. AudioClips is a trademark of Sound Source Unlimited.

Sound Source Unlimited, Inc.
2985 East Hillcrest Drive, Suite A
Westlake Village, CA 91362-9784
(800) 877-4778
(805) 494-9996
(805) 495-0016 fax
Makin' Copies

Makin' Copies is an extension inspired by Rob Schneider's annoying but hilarious "Copy Guy" skit on Saturday Night Live. Whenever you duplicate files, disks, or folders in the Finder, the Mac announces that you're "Makin' copies!" Like Rob's character, this baby doesn't do much but sit around all day long waiting for you to make copies. But hey, that's the kind of work ethic that made America great!

installing Makin' Copies

To install Makin' Copies, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the
Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation.

To de-install Makin' Copies, remove it from the System folder and restart. Actually, that only stops the Mac from saying "Makin' copies!" when you duplicate items. The words Makin' copies still replace the standard words in the duplication alert box. If you want to restore everything to normal, you must replace the modified Finder file with an original copy.

---

using Makin' Copies

To activate Makin' Copies, simply duplicate files, disks, or folders in the Finder just as you normally do. The Mac announces that you're "Makin' copies!" in an over-anxious digitized voice, and the alert box which normally reads Items remaining... now says Makin' copies instead.

---

companion disk goodies

As anyone who has seen the "Copy Guy" skit on SNL knows, Rob's character actually does more than just announce when someone is diddling with the Xerox machine. The routine usually starts off with
a play on the coworker's name—such as "Katherine...the Catwoman"—followed by the ever-popular "Makin' copies!" remark. If you like, I'll create a custom version of Makin' Copies that actually speaks your own name in glorious digitized fidelity! For details, see the Companion Disk Offer at the back of the book.

compatibility notes

Makin' Copies works under System 6 and System 7. When used with a utility that speeds up Finder copying (such as Fifth Generation Systems' CopyDoubler or CSG Technologies' COPYright), Makin' Copies is silent, so don't bother loading it in the first place.

contacting the programmers

Makin' Copies is freeware that is copyright © 1991, Eric Hayes and Jim Wolff.

Eric J. Hayes
1795 S.W. 144th Avenue
Beaverton, OR 97005-1084

Jim Wolff
Apollyonics Software Development Inc.
3048 Kenmore Street
Berkley, MI 48072-1682
(313) 545-1589
(313) 545-7280 fax
America Online: Apollyonics
AppleLink: Apollyonics
Part III: Random Cool Stuff

The eight programs covered in this section don’t fit nicely into any of the other categories I created, so they’re relegated to their very own Island of Misfit Toys. But these programs aren’t cast-offs in any sense of the word. Included in this section are some of the coolest programs in the whole book. DarkSide is a full-blown screen saver that displays animations during periods of inactivity, much like the commercial programs After Dark and Pyro. Kilroy is a silly bald-headed guy that peeks over dialog boxes if you wait too long. SuperApple and MICN are programs that replace the static Apple icon and text in the menu bar with animations and icons, respectively. TailDragger makes the cursor to point in the direction of the mouse movement. Momentum allows you to “throw” outlined objects around the desktop, complete with bouncing sound. The Ripper tears windows, leaving them fully functional, but with jagged edges. Finally, Wacky Lights makes the LEDs on extended keyboards flash in a back-and-forth sequence. Like I said, these programs don’t fit anywhere else in the book, but they’re sure to find a permanent home on your hard drive.
DarkSide

DarkSide is a "screen saver" that displays animations to prevent static images from burning into the phosphors on your monitor. Yeah, right...and politicians were put on this planet to help people! Such an explanation might help you justify having such a silly program on your system, but the real appeal of screen savers is that they're cool. After a user-specified period of inactivity, the screen saver kicks into action, displaying fireflies, searchlights, personalized messages, kaleidoscopes, geometric patterns, etc. until you
press a key, move the mouse, or insert a disk. The version of DarkSide included in this book comes with a collection of a half-dozen “faders,” which control the animation you see on screen after a user-specified period of inactivity, and many more are available from the programmer and in the public domain. What’s more, you can even use popular After Dark modules!

**installing DarkSide**

Unlike other screen savers, which operate as system extensions, DarkSide is an application, and as such doesn’t need to go anywhere special on your hard drive. Put it wherever you normally keep applications and utilities.

Double-click DarkSide to present a dialog box where you can enter your Name and Company, then click Install.

---

**Before installing DarkSide, please enter your name, and the name of your company.**

**Name:**

**Buckwheat**

**Company:**

**Little Rascals**
In the dialog box that follows, click Install to have DarkSide automatically place an alias of itself into the Startup Items folder inside the System folder. Then, each time you turn on the computer or choose Restart from the Finder’s Special menu, DarkSide immediately launches when the desktop appears. If you subsequently move the original DarkSide application, you should choose Install DarkSide (⌘-I) from the File menu so that the alias knows about its new location.

---

**using DarkSide**

Once DarkSide is running, choose Open Fader (⌘-O) from the File menu to present a standard file selection dialog box.

Locate the Faders folder on your hard disk, and keep clicking Open until you’ve selected one of the faders residing in the folder. Faders
are small modules that animate your Mac screen during periods of inactivity. A brief description of each of the faders included with this book follows.

**Boids:** Keith McGregor created this CPU-intensive but totally neat implementation of “flock behavior.” You can set the number of boids. If it runs slow on your Mac, reduce the number of boids.
**Kaleidoscope:** Alan Mimms did this electronic implementation of a kaleidoscope in his "spare" time. A really fun one that looks stunning in color, and pretty darn good in black & white, too. The settings allow you to choose lines, rectangles, or ovals. (Inverted for reproduction purposes.)
**Puzzle:** This gem splits up the desktop into lots of little tiles, then shuffles them around like the stupid Puzzle desk accessory that Apple insists on including in the System software suite. Unlike the worthless Puzzle DA, this fader is really cool. You can set the thickness of the lines separating the tiles.
Searchlight: This fader blacks out the screen, then scans it with searchlights that reveal the desktop wherever the light falls. You can set the number, size, and speed of the searchlights.
**String:** This one lets you enter a string of text to be displayed upon fading. It's great for leaving a message on your monitor while you are away from your Mac. The text string is saved to disk, so if you don't change it within 30 seconds of activation, the old message is used by default. You can set the message, font, and size.

I'm away for a bit...
**Trig:** This fader draws interesting spirographic patterns on the screen using simple high-school trigonometry. It's just $x = r \times \cos(\text{angle})$ and $y = r \times \sin(\text{angle})$, folks! But it sure does look pretty, doesn't it? The program randomly generates new deltas for the radius, and the angle increases, resulting in neat patterns. You can set the number of points, trail size, size of dots, and color display. (Inverted for reproduction purposes.)

To see what a particular fader does, open it, choose Fade Now (📷-F) from the File menu, then don't touch a thing. Once you're satisfied with your choice, press any key or move the mouse to clear the screen.

All of the faders included with this book have settings that you can change to affect their presentation. Choose DarkSide Settings (📷-S) from the File menu to present the DarkSide Settings window.
The options in the large box on the right vary, depending on the current fader selected in the scroll box on the left, but they all should be pretty much self-explanatory. Highlight a fader, then click Test Fader. Since the DarkSide Settings window remains visible with the fader operating in the background, you can experiment with the various settings to see what they do. When you are finished, click Done Testing. Try clicking and holding down the ? button to display more information about the current fader. For more information on the options at the top of the DarkSide Settings window, read on...

The Fade the screen after text field determines how long DarkSide waits for inactivity before it kicks in and runs a fader. You can enter any number you wish, and choose the unit of time from the pop-up menu. Experiment with different values to find a setting that works best for you. Too short a wait and DarkSide starts up when you're just collecting your thoughts; too long a wait and it never kicks in
when you want. DarkSide considers typing, clicking the mouse, moving the mouse, and inserting disks as activity. It attempts not to fade when a program is calculating, or doing some other processor-intensive task.

There are times when you won't want DarkSide to take control automatically. Perhaps you are checking out a self-running demo or reviewing a long presentation that doesn't require user activity. To temporarily turn off DarkSide, move the mouse cursor to the corner of the screen designated the Don't Fade corner, then click and leave the mouse where it is.

Conversely, if you want DarkSide to kick into gear immediately—perhaps you're running out to lunch, or you're viewing dirty pictures and your mom/boss/authority figure just walked into the room—move the mouse cursor to the corner of the screen designated the Fade Now corner, then leave the mouse where it is. There is a two-second delay from when you move the mouse into the Fade Now corner and when the fade occurs. By the way, it's a good idea to designate Don't Fade and Fade Now to opposite corners so you don't accidentally use one instead of the other. If you try setting them to the same corner, an international no sign appears on one of the screen icons indicating that's a no-no.

All it normally takes to stop a fader is to move the mouse or press a key. If you want to keep curious passers-by from prying into your Mac, enter a password into the Unfade Password text field (type your password carefully and remember that DarkSide is case-sensitive). Now when activity is detected, DarkSide presents a dialog box requesting your password before it unfades. Enter your password and click OK to unfade, or click Cancel to return to the fader, or click Quiet to turn the sound off. If someone has entered incorrect passwords in your absence, these attempted entries are displayed in a log when the fader stops. Please note that this password option, like all locks, simply keeps honest people honest. It will not stop determined snoopers from gaining access to your machine by pressing ⌘-Option-Esc to force DarkSide to quit. To change a password, highlight the bullets that represent the existing
password, then type a replacement or press Delete to remove it altogether.

If you use System 7's File Sharing feature, select the Turn on File Sharing upon fade checkbox. That way, whenever DarkSide fades, it automatically enables File Sharing and returns File Sharing to its previous state upon unfading. This option is useful if you are using someone else's Mac on the network and then you realize that you need some files from your own Mac. With this option selected, your files are available to you even when DarkSide has faded.

Select the Adjust screen depth upon fade checkbox so that DarkSide automatically switches to the best display setting for each fader, then reverts back when done. This is particularly useful if you like to set your Monitors control panel to display only Black & White for best performance while you work, but you would like to see screen savers in all their colorful glory.

If you placed an alias to DarkSide in the Startup Items folder, as recommended in the Installing DarkSide section, DarkSide automatically launches when the Finder’s desktop appears. However, it also remains in the foreground, which some people find annoying. If that bugs you too, select the Finder to front upon startup checkbox.

Select the Confirm before quitting checkbox if you want DarkSide to present a confirmation dialog box when you choose Quit (⌘-Q) from the File menu. This makes it more difficult to quit DarkSide by mistake.

Some faders produce sounds during the fade process. The Sound slider controls the volume used for all DarkSide sound effects. Set it to whatever level is best for your particular environment.

If you want a little variety, select Random fade in the scroll box. Instead of using the fader you previously opened, DarkSide picks either at random or in sequence (depending on the radio button you select) from the faders in the current folder. By dragging the slider, you can determine how often DarkSide picks a new fader.
Once you've fiddled with the DarkSide and fader settings, there's no need to do it again unless you change your mind. The settings are saved to disk (as DarkSide Preferences in the Preferences folder), and now you can forget about DarkSide entirely and focus on using your Mac as normal. DarkSide will always be there in the background, waiting for you to take a break or lazily look out the window.

**companion disk goodies**

Included in this book are a half dozen DarkSide faders which control the animations you see when the Mac is left idle. There are many more faders available in the public domain, but due to disk space constraints, I wasn't able to include more on the disk that comes with this book. If you would like additional faders, see the Companion Disk Offer at the back of the book.

**compatibility notes**

DarkSide requires System 7. In addition to its own faders, DarkSide can run most modules written for Berkeley Systems' popular After Dark screen saver, as long as they are placed in your Faders folder.

**contacting the programmer**

DarkSide is copyright © 1989–1993, Tom Dowdy. DarkSide and these faders are freeware, but may not be sold or included in any product sold for profit without Tom Dowdy's prior written permission. If you like DarkSide and these faders, drop Tom a card and
let him know. To register, please send $15 (U.S. funds) and Tom will send you a release disk with the latest version of DarkSide and the full complement of faders, plus a printed manual.

Tom Dowdy  
1610 Kamsack Drive  
Sunnyvale, CA 94087-5212  
AppleLink: Dowdy1
Back in World War II, soldiers entertained themselves by painting everything in sight with simple figures of a curious little bald-headed guy that looked as if he was peering over a wall or peeking out of a foxhole, depending on your point of view. The graffiti was almost always accompanied by the words “Kilroy was here.” Nobody is really sure how or why this fad got started, but now it can live on inside your Mac. Kilroy—whenever he is—hangs out in the background, waiting for you to take a break. When you do, Kilroy appears, taking a look around. Pretty soon, you’ll start to fondly think of Kilroy as a member of the family (albeit one who doesn’t send you birthday presents).
installing Kilroy

To install Kilroy, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Control Panels folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation. (To de-install Kilroy, remove it from the System folder and restart.)

using Kilroy

Before Kilroy can start popping up all over the place, you must tell him how long to wait before making his entrance. Open the Kilroy control panel by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.

By Dave Koziol

With special thanks to:
Leonard Rosenthal
Mary Lynn Samford

How many minutes should Kilroy wait? [ ]

Kilroy is PostCardWare! If you use it, you MUST send a PostCard to

Dave Koziol
PO Box 7794
Ann Arbor, MI 48107

Written at MacHack 1990 & 1991!!
The Kilroy control panel contains only one text box. Enter the number of minutes of user inactivity that should go by before Kilroy appears. Experiment with different values to find a setting that works best for you. Too short a wait and Kilroy shows up all the time; too long a wait and he hardly ever makes an appearance. When you are done, click the close box and go on with your work as normal.

Now whenever an alert box, dialog box, or window is left on screen too long without user activity, Kilroy peeks over the top and his eyes follow the cursor. Move the cursor between his eyes to make Kilroy cross-eyed!

As shy as a leprechaun, Kilroy quickly disappears the moment you press a key or click the mouse. But never fear. He's always hiding somewhere inside your Mac, waiting for you to take a break before he pops up again to see what's going on.
compatibility notes

Kilroy is compatible with System 7. It kinda runs under System 6, but its operation is somewhat erratic—the desktop isn't always redrawn properly—so I don't really recommend Kilroy for System 6 users.

contacting the programmer

Kilroy is copyright © 1990–1991, Dave Koziol. Kilroy is postcard-ware, so if you like it, you must feed Dave's ego by sending him a postcard saying that you think Kilroy is the coolest.

Dave Koziol
2034 Bancroft Drive
Ann Arbor, MI 48103-9759
AppleLink: Koziol
America Online: DaveKoziol
SuperApple

Are you the kind of person who doesn't wear clothing emblazoned with company logos because you refuse to be a walking billboard? Then why do you allow that silly Apple logo to appear constantly in the upper left-hand corner of the Mac's desktop? Strike a blow against creeping commercialism with SuperApple. This nifty control panel comes with a slew of animated icons that replace the staid Apple logo. Choose from a spinning Mac, flying bird, nose-picking moron, counting fingers, and many more.

installing SuperApple

To install SuperApple, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining
that the file belongs in the Control Panels folder. Click OK and let
the Finder put it in the right place. Then choose Restart from the
Finder's Special menu to complete the installation. (To de-install
SuperApple, remove it from the System folder and restart.)

---

**using SuperApple**

Open the SuperApple control panel by double-clicking its icon
under System 7, or choosing the Control Panel desk accessory from
the Apple menu under System 6.
Make sure SuperApple is active by turning the Master Switch on. If you want to temporarily disable SuperApple without removing it from your System folder, click Off. If SuperApple is active, you should notice that the standard Apple logo has been replaced by the animation that's highlighted in the scroll box. To change animations, just click one of the other choices in the scroll box and it takes effect right away. Also, the individual icons that make up the animation appear at the bottom of the window. Click the arrows at either end to see what, if anything, lies beyond the boundaries.

Experiment with different animation speeds by clicking the Speed Control arrow buttons. Your choices range from Slowest to Fastest, or you can halt the animation altogether by setting the Speed Control to Stopped.

If you're not happy with the animations built into SuperApple, why not design your own? The easiest way is to select an animation, choose Copy from the Edit menu, then paste the series of icons into a graphics application or ResEdit. Make whatever changes you like as long as the image is at least 16 pixels high with every frame exactly 16 pixels wide. Copy the finished series to the Clipboard, switch back to SuperApple, then choose Paste from the Edit menu to present a dialog box.

The name of the new item:

New Animation

Cancel  OK
Enter a name for your modified icons, then click OK to make them a permanent addition to SuperApple. If you change your mind, click Cancel instead.

The easiest way to share your animation creations with friends is to click Export. This presents a standard file selection dialog box, giving you the opportunity to save the highlighted animation to disk with whatever name you like. Your friends can then add your animation to their collection by clicking Import and opening your file. In addition to its own file format, SuperApple can also import animations created with CursorAnimator (a popular public domain utility for editing cursors) or ResEdit (cursor resources with a type of CURS or csr must be gathered in sequence into an animation resource type acur).

Keep in mind that you can always get rid of an animation by highlighting it in the scroll box and choosing Clear from the Edit menu. Don't worry, you'll be asked to confirm that you really want to delete an entry.

When you're all done, click the close box and SuperApple replaces the Apple icon with whatever animation is currently selected. Feel free to come back and make changes periodically as your mood and preferences change. Or select the Randomize checkbox and SuperApple automatically picks a new animation every time you start the Mac.

compatibility notes

SuperApple works under System 6 and System 7.
contacting the programmer

SuperApple is copyright © 1991–1993, Jan Bruyndonckx. SuperApple is freeware. To become a registered owner, just send Jan a postcard of your hometown.

Jan Bruyndonckx
Salvialei, 23
B-2540 Hove
Belgium
AppleLink: Wave.Bel
In the previous chapter I introduced you to SuperApple, which replaces the Apple menu's icon with the animation of your choosing. But what about all those other menus? Wouldn't you like to replace the plain text with something a little more spiffy? Well, now you can, thanks to MICN, a control panel that saves menu bar space by replacing common menu titles with small icons.
installing MICN

To install MICN, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Control Panels folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder’s Special menu to complete the installation. (To de-install MICN, remove it from the System folder and restart.)

using MICN

Open the MICN control panel by double-clicking its icon under System 7, or choosing the Control Panel desk accessory from the Apple menu under System 6.
Make sure MICN is active by clicking On in the upper-left corner. If you want to temporarily disable MICN without removing it from your System folder, click Off. If MICN is active, you should notice that the standard menu titles have been replaced by icons.

MICN comes configured to display icons for a dozen different menus. To see which ones are ready to go, click the down arrow and a pop-up menu appears.
To see the icon assigned to a particular menu title, choose the title from the pop-up menu. The scroll box directly below the text field displays the icon as it appears when the menu is available, as well as the dimmed version when the menu is present but unavailable.
Note that a single icon can be used for more than one title. For instance, Window and Windows share the same icon.

If you don't like the icon pair assigned to a particular menu title, you have three choices: edit the existing icons, assign different icons, or don't iconize.

- To edit an existing icon, select it from the scrolling list. You can now modify the "available" icon in the lower-left editing square in the usual "fat bits" style. Basically, you can turn each individual pixel on or off by clicking with the cursor. There's no support for color, nor can you use the Edit menu's Cut, Copy, or Paste commands. Once you're happy with the "available" icon, click the dimmed triangle to the right of the editing square to place a
“dimmed” version of your icon into the right-hand editing square. Feel free to make further modifications on either side.

- To reassign an icon pair, choose the menu title from the pop-up menu, select the new icon pair from the icon list, then click the + button.
- If you decide that you don’t want a certain menu title to be replaced by an icon after all, choose the menu title from the pop-up menu, then click the – button. This removes the title from the pop-up menu, but does not remove the icon pair from the scrolling icon list. To remove an icon pair, you must resort to ResEdit.

Suppose you want to iconize a particular menu title for which MICN is not configured, such as the Tools menu in Microsoft Word 5.0. In the text box, enter the menu title exactly as it appears in the application. Now you have two options: you can either use an existing pair of icons, or you can create your own.

- To assign a title to an existing icon pair, scroll through the icon list to see if there is something that suits your fancy. If there is, just click the desired icon, then click the + button to add Tools (or whatever you’re modifying) to the pop-up menu with the corresponding icon.
- If you don’t see anything appropriate, you can add a new icon pair. Start by scrolling the icon list all the way to the right, clicking the blank space at the right end, then editing in fat bits mode. The hardest part is devising an icon that reminds you of the menu title it replaces. When you’re finished, click the + button to add the menu title to the pop-up menu with the corresponding icon.
Finally, if you want the MICN icon to appear along the bottom of the screen during startup, select the Show Icon checkbox. If you prefer not cluttering up the Startup Screen, deselect the checkbox. This checkbox affects the MICN icon only; the icons of other control panels and extensions still appear as always.

Any changes made to MICN's pop-up menu or icon list are retained when you click the close box, and they take effect the next time you restart your Mac. By the way, the ? button does nothing in this version of MICN.

---

**ResEdit tips**

To delete or change icons with more sophisticated editing tools than provided in MICN, modify the SICN resources using ResEdit. MICN is configured to display color icons for some standard menus. The only way to add or edit color icons is to modify the MICN and cicn resources using ResEdit, and the process is too involved to explain here. Perhaps if you nag the programmer, he'll add better support for color icons in a new version.

---

**compatibility notes**

MICN is compatible with System 6.0.5 and higher, including System 7.

---

**contacting the programmer**

MICN is copyright © 1992, Mark Valence. Although freeware, Mark prohibits anyone from charging for the distribution of MICN or
using any of his code in other programs. If you know of any offenders, bring them to Mark's attention, along with bug reports and suggestions for improving MICN.

Mark Valence
P.O. Box 150
Hanover, NH 03755-0150
Internet: kurash@gile.Dartmouth.edu
As you've just learned from reading the previous two chapters, it's easy to modify the Mac's menus. But did you know that you can do the same sort of customization to the omnipresent cursor? It's true. There are all sorts of programs for modifying the cursor, but one I like best is a simple extension called TailDragger. It's hard to explain what TailDragger does, and impossible to depict on the printed page. That said, let me take a shot at describing its function. Normally the arrow cursor points up and to the left, like the hand of a watch pointing to 11 o'clock. But with TailDragger, the arrow points in whatever direction the mouse is moving. It's a pretty simple trick, but one that gives the cursor a life of its own.
installing TailDragger

To install TailDragger, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation. (To de-install TailDragger, remove it from the System folder and restart.)

using TailDragger

You don’t “use” TailDragger in the conventional sense of the word. Just use your Mac as you normally would and enjoy the wacky way that the arrow cursor always points in the direction of the mouse movement. When I'm bored, I like drawing figure eights on the desktop, or zig-zagging between icons like a downhill slalom.

compatibility notes

TailDragger works under System 6 and System 7.

contacting the programmer

TailDragger is copyright © 1993, Jan Bruyndonckx. TailDragger is freeware; to become a registered owner, just send Jan a postcard of your hometown. Special thanks to Dan Venolia, whose original
TailDragger was the inspiration for this new, more compatible version.

Jan Bruyndonckx
Salvialei, 23
B-2540 Hove
Belgium
AppleLink: Wave.Bel
Computer pundits are always making noise about an esoteric concept called the "real world." Isn't it about time someone imposed a little of that reality on the computing environment? Momentum does just that by making Macintosh objects fall under the spell of physics. You remember, that was the high-school class in which you kept falling asleep as the teacher fiddled with tiny soapbox derby racers (a.k.a. prototype Yugas) on inclined ramps of
plywood. Basically, Momentum (or simply MO to those like Bo who know) allows you to throw objects around the Mac desktop and then watch as they bounce off the walls and eventually come skidding to rest. Gravity; not just a good idea...it's the law!

**installing Momentum**

To install Momentum, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Control Panels folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation. (To de-install Momentum, remove it from the System folder and restart.)

**using Momentum**

Before using Momentum for the first time, you should set some of the parameters that affect its operation. Open the Momentum control panel by double-clicking its icon under System 7 or by choosing the Control Panel desk accessory from the Apple menu under System 6.
To turn on Momentum, select the Give Me Momentum checkbox. If you want Momentum to work everywhere, deselect the Only in the Finder checkbox. And if you desire sound effects each time an object hits the edge of the desktop, select the With Bounce Sound checkbox.

The options in the Reality Coefficients box determine the Gravitational Force (bigger numbers equal more gravity), Gravity Direction (6 o'clock is normal and 12 o'clock is upside down, with objects "falling" towards the menu bar), Desktop Friction (bigger numbers equal more friction), and Bounce Friction (same deal).
When you're done configuring Momentum, System 7 users can click the animated icon for the settings to take effect immediately, but System 6 users must close the control panel by clicking its close box, then choose Restart from the Finder's Special menu.

To see Momentum in action, click on the title bar of an open window until the entire window has a gray or dotted outline, indicating that it is selected. Now, while still holding the mouse button down, rapidly jerk the mouse in any direction, then let go of the mouse button before the pointer goes off screen. It takes a bit of getting used to—kinda like eating sushi for the first time—but if you do it correctly, the outlined object should bounce around the screen for a while, then slowly come to rest as friction takes hold (press the S key to stop the object prematurely). Neat, huh? OK, maybe not too neat, but definitely a serious misappropriation of programming resources on the part of Momentum's creators!

Momentum should affect just about any object that gets an outline border when selected, with the notable exception of icons in the Finder. Yeah, I know, it's a serious bummer. But by way of making up for that limitation, Momentum has a sneaky way of allowing you to control the bouncing object interactively. When an object is under the influence of Momentum, you can control its trajectory by pressing the arrow keys. Done correctly, you can keep an object skittering all over the desktop forever. Why the heck would you want to do that? Don't ask me...why would anyone waste time writing Momentum in the first place, except to demonstrate to the world that they have way too much time on their hands?

**compatibility notes**

Momentum works under System 6 and System 7. In some applications, however, Momentum may restrict the movement of outlined objects in an undesirable fashion. In such cases, open the Momentum control panel and deselect the Give Me Momentum checkbox or select the Only in the Finder checkbox.
contacting the programmers

Momentum is freeware copyright © 1992, Exodus Software.

Jim Stegman
Exodus Software
800 Compton Road, Unit 11
Cincinnati, OH 45231-3848
AppleLink: Exodus

Bill Johnson
Pharos Technologies
8118 Corporate Way
Mason, OH 45040-9560
AppleLink: D0473
CompuServe: 72257,2064
GENie: WJohnson
Much as we all love our Macs, let's face it, there are times when you just want to kill the silicon sucker. The Ripper is a function key (FKEY) that provides a harmless outlet for that computer stress by tearing windows in half! It's completely harmless, but terribly satisfying nonetheless.

installing The Ripper

The Ripper is an FKEY and, as such, should be installed with FKEY Master, also included in this book. See Chapter 21 for detailed instructions.
using The Ripper

Whenever your Mac causes problems, take out your frustrations with The Ripper by pressing 6-Shift and the number to which you've assigned the FKEY. If you install The Ripper with ResEdit, Suitcase II, or something other than FKEY Master, be advised that the default is 6-Shift-6, but this can be changed if you know what you're doing. Once invoked, The Ripper tears the active window asunder.
to the sound of shredding paper. It's a little disconcerting when your document is severed in half and the bottom disappears,

but in reality The Ripper is quite harmless. To restore a window to its pristine condition, simple click the close box (⌘-W) and then open the window again.

• • • • • • • • • • contacting the programmer

The Ripper is freeware, copyright © 1989, Random Dot Software. It may be given away, but not sold, except by "freeware distributors," who may charge a nominal media or transmission fee.

Steve Blackstock
Random Dot Software
2148 Commonwealth Avenue
Newton, MA 02166-1603
AppleLink: RandomDot
CompuServe: 73270,1150
As if to prove conclusively once and for all that there is no program too frivolous to write, the prolific public domain author Andrew Welch hacked together a little gem called Wacky Lights. This extension simply plays with the lights on the Apple Extended Keyboard, bouncing them back and forth like some bogus television producer's vision of what a computer should look like. By the way, have you ever noticed that computers on TV and in the movies always have flashing lights like some twisted Tijuana taxi, invariably speak in a stiff "Danger, Will Robinson" robotic voice, and make dot-matrix or TeleType printer noises when displaying text on screen? Come on, do producers think we're as stupid as they are? We know only IBM PCs do all those things!
installing Wacky Lights

To install Wacky Lights, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation. (To de-install Wacky Lights, remove it from the System folder and restart.)

using Wacky Lights

You don't have to do anything to use Wacky Lights. Once loaded, the Num Lock, Caps Lock, and Scroll Lock lights at the upper right on an Apple Extended Keyboard flash in a back-and-forth sequence. The program has absolutely no utility aside from making your keyboard emulate Kitt's engine grill from the thoroughly forgettable television series, The Knight Rider.

compatibility notes

Wacky Lights works under System 6 and System 7 and is smart enough not to do anything if you don't have an Apple Extended Keyboard connected to your Mac's ADB (Apple Desktop Bus) port.
contacting the programmer

Wacky Lights is freeware, copyright © 1991, Andrew Welch.

Andrew Welch
Ambrosia
P.O. Box 23140
Rochester, NY 14692-3140
(716) 427-2577
(716) 475-9289 fax
America Online: AmbrosiaSW
AppleLink: Ambrosia.SW
CompuServe: 73424,1226
Part IV: Shutdown

Much as you might love playing with your Mac, there comes the time when you must call it a day and choose Shut Down from the Finder's Special menu. Normally this results in the Finder taking care of some disk business, then the screen turns to black in the blink of an eye. To spice things up, allow ShrinkDown to shrink the screen to a little dot, just like an old television set being turned off. Or perhaps you'll prefer how Shutdown Fade fades the screen gradually instead of just going black in a flash. Who says parting is such sweet sorrow? With ShrinkDown and Shutdown Fade, it can be kind of fun.
The Mac is pretty cool, but let's face it, the shut down procedure is pretty generic stuff. Choose Shut Down from the Finder's Special menu and the monitor just goes blank in one fell swoop. Boring! ShrinkDown causes the monitor to turn off like a television set of old, ending in a brilliant point of light in the center of the screen. Reminds me of turning off the ancient Zenith at my grandparents' house after watching some black-and-white western into the wee hours of the morning. It occurs to me that perhaps I wouldn't be writing about stupid Mac programs today if I hadn't twisted my chromosomes by sitting too close to that old boob tube. Thanks grandma and grandpa!
installing ShrinkDown

To install ShrinkDown, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation. (To de-install ShrinkDown, remove it from the System folder and restart.)

using ShrinkDown

Once installed, ShrinkDown does its stuff whenever you choose Shut Down from the Finder's Special menu. There are no commands, no options, no variations. ShrinkDown does just what its name implies.

compatibility notes

ShrinkDown works under System 6 and System 7. You can have either ShrinkDown or Shutdown Fade (see the next program) installed at any given time, but not both. Try them out and use whichever one you like best.

contacting the programmer

ShrinkDown is a freeware program from Scott Fenton.

Scott Fenton
P.O Box 711
Williston, VT 05495-0711
America Online: ScottF2
In the previous chapter I introduced you to ShrinkDown, an extension that causes the screen to shrink down to a little dot whenever you choose Shut Down from the Finder's Special menu. Perhaps you'd like an alternative. Allow me to introduce Shutdown Fade, an extension that makes your screen fade out when you choose Shut Down from the Finder's Special menu. It's not a true fade in that it doesn't adjust the brightness, or use grayscales. Rather, it uses a series of patterns that go, in steps, from white to gray to black.
installing Shutdown Fade

To install Shutdown Fade, just drag it into the System folder on your startup volume. Under System 7, an alert box appears explaining that the file belongs in the Extensions folder. Click OK and let the Finder put it in the right place. Then choose Restart from the Finder's Special menu to complete the installation. (To de-install Shutdown Fade, remove it from the System folder and restart.)

using Shutdown Fade

Once installed, Shutdown Fade does its stuff whenever you choose Shut Down from the Finder's Special menu. There are no commands, no options, no variations. Shutdown Fade just does what its name implies.

compatibility notes

Shutdown Fade works under System 6 and System 7. You can have either Shutdown Fade or ShrinkDown (see previous chapter) installed at any given time, but not both. Try them out and use whichever one you like best.

contacting the programmer

Shutdown Fade is freeware. If you like it, please send Andrew a postcard or e-mail message. Fellow programmers should note that
if you send a self-addressed stamped envelope, Andrew will send you the source code for Shutdown Fade.

Andrew McGeachie
32 Dover Road
Wellesley, MA 02181-7321
Internet: Geech@cs.BU.edu
Part V: Utilities

I confess. I lied in the Introduction when I said that all of the programs included in this book have absolutely no redeeming value other than the totally radical coolness they bestow on Macs and their owners. The truth is that the two programs covered in this section are utilities for getting the most out of the other programs on disk. Sound Mover is a little utility for moving sounds between files so they can be used by StartupSnd or SndControl, among others. And FKEY Master is a tiny utility for installing function keys (FKEYs) such as The Ripper. As you can see, these babies are useful after all. So sue me.
Sound Mover

Sound Mover is a utility that allows you to move sounds among files, as well as convert between several different sound formats. Much of the functionality of Sound Mover is duplicated by System 7, which already lets you move sounds from one suitcase to another as easily as copying any other kind of file. Still, Sound Mover has many unique features, recognizes many different types of sound resources, and is a must-have if you want to take advantage of all the features of StartupSnd and SndControl, covered in Chapters 5 and 8.
installing Sound Mover

Sound Mover is an application, and as such doesn't need to go anywhere special on your hard drive. Put it wherever you normally keep applications and utilities.

using Sound Mover

Launch Sound Mover by double-clicking its icon. A dialog box appears, one that bears a striking resemblance to Apple's Font/DA Mover utility, but instead of allowing you to move font and desk accessories between applications, Sound Mover works with sound resources.
By default, Sound Mover opens showing the sound resources currently installed in the System file. These are listed in the scroll box on the left, and the name of the open file (in this case, System) appears below, along with the amount of free space on that disk.

To install a new sound into the System file, click Open to present a standard file selection dialog box.

Click Desktop or Drive until you locate the volume that contains your sound files or suitcases, then open the appropriate folders until you can double-click the name of the file that contains the sound you want to install in the System file.

Sound Mover can open any type of file, not just sound files and suitcases. To do so, hold down the Option key and note that the Open button is renamed Open any. Click this button to present a standard file selection dialog box. Click Desktop or Drive until you locate the volume that contains the file you want, then open the appropriate folders until you can double-click the name of the file that might contain sounds. Depending on the type of file selected, you
may be presented with a dialog box asking whether you wish to open the resource or data fork of the file. Usually sounds are kept in the resource fork, but not always. If you open the data fork, be prepared to listen to some pretty strange "sounds." If you choose to open the resource fork, a dialog box appears that allows you to specify the type of resources in which to look for sounds.

In this file, look for sounds in resources of type:

- snd

Use the pop-up menu to choose a resource type you think may contain sounds. The best guess is usually the snd resource type, but who knows where you'll find sounds. (Another easy way to open sound resources within a file is to drag and drop the file on top of the SoundMover icon.)

For purposes of following along with the book, simply open one of the Star Trek sound files included in the AudioClips folder on the enclosed disk. The Sound Mover dialog box now shows the sound resources currently installed in the file you just opened. These are listed in the scroll box on the right, and the name of the open file appears below, along with the amount of free space on that disk. If Sound Mover finds any nameless sound resources, it gives them a number corresponding to the ID of the resource. To
change its name, select it, then choose Rename from the Edit pop-up menu.

Click the name of any sound resource and that sound is automatically played (Option-click if you prefer silence). To change the volume at which a sound is played, move the slider directly below the speaker icon in the center of the dialog box, then click the speaker icon to hear the sound played at its new volume setting.

Whenever you play a sound, several areas of the dialog box display useful information. For instance, the selected sound's sampling rate (in kilohertz), resource type, and size (in bytes) are all displayed below the volume control slider. The higher the sampling rate, the more disk space required and the better the sound. Sounds sampled at 22K require roughly 22 kilobytes of memory per second, whereas 5K sounds save disk space but don't sound as nice.
The sound's waveform appears at the bottom of the dialog box, with a scroll bar allowing you to see any portions that don't fit on the screen. Sound Mover contains some rudimentary editing features, but for more sophisticated editing, I recommend you invest in a copy of Macromedia's SoundEdit Pro. Highlight a portion of the waveform, then use the Cut (⌘-X), Copy (⌘-C), and Paste (⌘-V) commands in the Edit pop-up menu to manipulate the waveform and move selections between sound files. Experiment by cutting a selection from one end of the waveform, clicking at the other end, pasting it back in, then play by clicking the speaker icon. To play only the highlighted section, press any key, or click the speaker icon. To play a section that has been cut or copied to the Clipboard, choose Play Clip (⌘-P) from the Edit pop-up menu.

The four radio buttons below the waveform determine the sound's playback rate (in kilohertz). Usually, you want to set the playback rate to match the sound's sampling rate, but some neat effects can be created just by using the "wrong" rate. Try clicking the different radio buttons or moving the slider bar to hear the different sound effects.

After you've screwed around with the sound, you may decide you liked it better in its original form. If so, click the Close button on the right to present a dialog box offering several choices.
If you want to keep a copy of the edited sound, change its name in the text field, then click Save. This creates a resource with the new name in the same file as the old sound. If you aren't sure, click Play to hear the sound. If that convinces you it's not worth saving, click Discard.

Once again, open a sound file you want to install in the System file and then click its name in the scroll box to hear it play. Notice that the Copy button at the top of the dialog box has arrows pointing to the left, indicating the direction that the sound moves. Click Copy and the resource is copied from the selected file on the right and into the System file on the left. Or Option-click Copy to move only the highlighted portion of the waveform. Finally, if you ⌘-Option-click Copy, the sound's size is cut in half (by removing every other byte) as it gets copied to the other side. Often there's no audible loss of sound quality, but the disk space savings can be tremendous and smaller sounds load quicker at playback time. This feature only works when copying one sound at a time.

If you try to copy a resource into a file that already contains a resource by the same name, an alert box appears to that effect. If you choose to replace the sound, its ID is preserved. This is especially useful in situations where a program refers to sounds by ID, not their names.

Sound Mover is also smart enough to convert incompatible sound types on the fly. For example, format 1 snds can be used as beeps but can't be played by HyperCard. However, if you try to copy a format 1 sound into a stack or the HyperCard application, Sound Mover converts the sound to format 2 automatically. The reverse is true for copying in the other direction.

After copying, the sound now appears in both scroll boxes. If you copied the wrong sound by mistake, select it and choose Remove from the Edit pop-up menu. You'll be asked to confirm whether you really want to remove the sound. When you're satisfied with your changes, click the Close button on the left to save the System file with its new sounds.
Using the basic techniques just covered, you should now know enough to copy sounds between files quite easily. In addition, there are a number of other features that are less apparent to the casual user but can be very helpful as you become more involved with sounds. These include creating new sound files, copying multiple sounds at a time, and generating lists of sounds in files. I'll cover these in the rest of the chapter.

Instead of adding sounds directly into the System file, suppose you want to create a new suitcase that contains sounds for use with Snd-Control. No problem. Launch Sound Mover, then immediately click Close. Now click either of the Open buttons to present a standard file selection dialog box. Click New to present a different dialog box, which allows you to specify the name, location, and type of file you want to create.
Locate your startup volume's System folder, enter snd as the file name, then click Create to make a Sound Mover suitcase file.

When the Sound Mover dialog box appears, both scroll boxes are empty because your snd suitcase doesn't contain any sounds yet, and you haven't opened a source for these sounds. Click Open, select a file that contains sounds, then copy them into the snd suitcase.

If you've opened a file that contains multiple sounds, instead of copying each one over individually, ⌘-Shift-click to select several at a time for batch copying. The total byte size and number of sounds selected appears below the speaker icon. If multiple sounds are selected, clicking the speaker icon plays each in turn. To stop playing, hold the mouse button down until the currently playing sound is over. When you're done copying sounds into the snd suitcase, click its Close button to save the changes to disk.

If you Option-click Close, a dialog box appears allowing you to create a text file containing a list of the names and sizes of all the sounds contained in the file you are closing. The default name is the same as the file, with .contents appended. The text file can be opened using any word processor and most databases.

companions disk goodies

You may be wondering how to get your greedy little paws on other cool sounds. If your Mac comes with a built-in microphone jack, you've got everything you need (see your Mac's documentation for instructions on using the Sound control panel). If you lack a microphone, consider buying Macromedia's MacRecorder. This little device attaches to a serial port and can digitize and edit sounds. If you don't want to bother recording your own sounds, you can obtain sounds from user group libraries, on-line information systems, and commercial public domain distributors.
If cool sounds elude you, no problem. I've assembled an eclectic collection of sounds suitable for use as with StartupSnd, SndControl, and Sound Mover. For details, see the Companion Disk Offer at the back of the book.

**compatibility notes**

Sound Mover works under System 6 and System 7.

**contacting the programmer**

Sound Mover is a part of the shareware Sound Manager Package. For $25, you get the latest versions of StartupSnd, Sound Mover, SndControl, and IBeeep2, plus a printed manual sent to any part of the world via air mail. The programs are not in the public domain, but rather are copyright © 1987–1992, Riccardo Ettore, with portions also copyright © 1986, Think Technologies.

Riccardo Ettore  
67 Rue De La Limite  
1970 Wezembeck-Oppem  
Brussels, Belgium  
Phone: 32-2-7679217 (never after 3 PM EST)  
America Online: R.Ettore  
AppleLink: BEL0128  
CompuServe: 72277,1344  
GEnie: R.Ettore1
FKEY Master is a small utility that lets you easily install, remove, and move "function keys," commonly called FKEYs. FKEYs are small programs that do all sorts of things, from changing the Mac's speaker volume to switching between color and black-and-white monitor settings. Many people are under the mistaken assumption that FKEYs are launched by pressing keys F1 through F15 which appear on the IBM-like Apple Extended Keyboard. In fact, FKEYs are usually invoked by pressing #–Shift in conjunction with a number from 0 through 9. Unfortunately, Apple doesn't provide an easy way to install FKEYs, but now that you've got FKEY Master, who
cares? By the way, if you already own a program capable of installing FKEYs (such as Fifth Generation Systems' Suitcase II), feel free to use it instead of FKEY Master.

installing FKEY Master

FKEY Master is an application, and as such doesn't need to go anywhere special on your hard drive. Put it wherever you normally keep applications and utilities.

using FKEY Master

Even though FKEY Master has proven extremely reliable over the years, some users are apprehensive about making unnecessary changes to the active System file. As a precaution, make a duplicate of your System file before running FKEY Master, then drag the copy out of the System folder and onto a floppy disk (if it doesn't fit on a floppy, just make sure this duplicate System file isn't left in the System folder or the Mac could get confused the next time you restart). With a backup safe in hand, if something does go wrong while using FKEY Master, or your System file is corrupted at some later point by unknown forces, you can always replace the bad System file with the fresh copy you just made.

To launch FKEY Master, double-click its icon. In the FKEY Master window there are ten “slots” numbered 0 through 9.
If an FKEY is already on the Clipboard, its name appears in the top-right corner of the window. Likewise, if a particular slot already has an FKEY installed, its name appears to the right of the corresponding number. For example, on most Macs, FKEY 3 is used by Apple’s screen shot utility (pressing `Alt`-Shift-3 takes a “picture” of the entire screen and saves it to disk as a PICT file under System 7, or a MacPaint file under System 6).

The first step is to select the FKEY slot with which you’d like to work. Suppose you want to install The Ripper FKEY (see Chapter 16) in slot 4. Click anywhere inside the box that surrounds the
number 4 to present a small dialog box. (Note: FKEYs 1 and 2 are reserved by Apple—pressing ⌘-Shift-1 ejects the disk from the internal floppy drive and ⌘-Shift-2 ejects the external disk—so FKEY Master doesn’t allow you to use these slots.)

The selected FKEY ID Slot is: 4

Copy  Paste
Install...  Remove

OK

The five buttons in this dialog box are pretty much self-explanatory:

- Click Copy to place the selected FKEY onto the Clipboard.
- Click Paste to insert the Clipboard’s FKEY into the selected slot.
- Click Remove to clear the selected FKEY.
- Click Install to import an FKEY from an outside file into the selected slot.
- Click OK to return to the FKEY Master window.

Since The Ripper FKEY is not on the Clipboard, but in a separate file on your hard disk, click Install to present a standard file selection dialog box.
Click Desktop or Drive until you locate the volume that contains your FKEY files, then open the appropriate folders until you can double-click the name of the FKEY file you want to install in the selected slot. All folders and files are shown even though they may not actually contain FKEYs. If the selected file contains a single FKEY only, FKEY Master installs it automatically. However, if the file contains multiple FKEYs, you must specify the one you want. If the file has more than one FKEY, a new dialog box appears with three buttons:

- Click OK to install the FKEY named in the dialog. (If the name is not present, an ID number is displayed instead.)
- Click Cancel to abort the entire installation operation.
- Click Next to see the next FKEY in the file. Continue clicking Next until the FKEY you want appears, then click OK.

After you've installed all the FKEYs you want, check the main FKEY Master window to make sure each is assigned to the keys you desire.
To save all your changes, simply choose Save Changes from the File menu. Then choose Quit from the File menu.

compatibility notes

FKEY Master works under System 6 and System 7.
contacting the programmer

FKEY Master is copyright © 1992, by Adam Stein. Until you register your copy of FKEY Master, you can’t use slots 8 or 9. To register and order the entire System 7 Companion Pack, choose Print Registration Form from the File menu, fill in the form, and drop it in the mail along with a $19.95 check payable to Adam Stein. (Using the registration form, you can also order other Insanely Great Software products such as the highly acclaimed $29.95 System 7 Pack.) Shortly after receipt of your check, you’ll get a postcard with a code. Choose Enter Password from the Apple menu to present a dialog box in which you can enter the code.

Adam Stein
Insanely Great Software
126 Calvert Avenue East
Edison, NJ 08820-3825
America Online: AdamStein
CompuServe: 71140,2051
Part VI: Exclusive Offers

Several commercial software publishers are proud to offer special deals exclusively to readers of *Totally Rad Mac*. Logical Solutions is so sure that you'll want to buy Chameleon after seeing its shareware counterpart, Before Dark, that it has put together some attractive deals you don't want to miss. Likewise, Now Software is confident that once you get hooked on SndControl, you'll reach for the phone to order an improved version in the Now Fun! package at an unheard-of discount. Finally, there's an order form for my very own Companion Disk that I've shamelessly plugged elsewhere in this book.
Special Offer for Totally Rad Readers!

Now Software is offering readers of *Totally Rad Mac Programs* the chance to customize your Mac with Now Fun!™ for a totally rad price of only $24.95!

Now Fun! makes your Mac wild, colorful and downright fun with this fascinating array of 30 screen savers, 30 custom colors schemes, 60 animated cursors, 40 vibrant desktop images, and 100 outrageous sounds (which includes an enhanced version of SndControl).

**Now Fun! only $24.95!**

Mail or Fax your order to:
Now Software, Inc., 921 S.W. Washington St., Ste. 500, Portland, OR 97205, Fax 503.274.6390

<table>
<thead>
<tr>
<th>Qty</th>
<th>Product</th>
<th>List</th>
<th>Special</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Now Fun!™ 1.0.1</td>
<td>$69</td>
<td>$24.95</td>
<td></td>
</tr>
</tbody>
</table>

*Shipping & Handling (U.S. UPS Ground)*

Total Due

| □ MasterCard □ VISA □ AMEX □ Check (Payable to Now Software) |

Credit Card Number (or check number) Expiration Date

Name
Organization
Street Address for Parcel Delivery
City State/Province Zip Code/Postal Code
Business Phone Home
Country

Signature

* $6 per single unit or $3 per unit for multi-unit orders in US and $9 per single unit or $4.50 per unit for multi-unit orders in Canada, Alaska & Hawaii.
FREE DESKTOP PATTERNS

Here's a Special Offer just for Readers of Totally Rad Mac Programs:

Buy Chameleon, the commercial version of Before Dark, and get your copy of the Ultimate Patterns Volume I disk absolutely free!

This collection of 195 patterns from HSC Software, Chris Marshall Design, N. Jonas Englund, Design Edge Media Corp and LSI give you a spectrum of patterns that cover nearly every subject, color and texture. Just a few examples from the Ultimate Patterns Volume I appear around the border of this page. This $25 value is yours free with the purchase of Chameleon.

Chameleon includes all the tools you need to create and display beautiful color, gray scale or black & white desktop patterns quickly and easily. It's handy Editor makes editing or creating new patterns a snap, and it's packed with other features not in the shareware version. Chameleon also comes with the entire Artbeats Marble & Granite pattern set and color reference chart, over 120 of the best seamless tiles and marble textures available.

The only way to get your free Ultimate Patterns disk, the Artbeats patterns, and the best desktop pattern software is to buy Chameleon! Take $25 off of the $59.95 retail price and pay just $34.95 + S&H! There is no better value in desktop pattern software, and with the Ultimate Patterns Volume I disk included for free, you save $50!

Send your check or money order for $40.90 (in U.S. funds) to:
LOGICAL SOLUTIONS, INC.
2124 University Avenue, Ste. 102
St. Paul, MN 55114-1838

Or for quicker service, use your Visa or MasterCard:
Call our order line at (800) 645-2495 or fax us at (612) 659-2498.

Give us a call at (612) 659-2495 if you have any questions, comments, or if you would like to submit patterns for the next Ultimate Patterns disk!

(Remember: Minnesota residents must add 7% sales tax)
STOP THE PRESSES!!!

Through a special incentive program, we can offer Readers of Totally Rad Mac Programs the 7th Heaven Utilities—which includes Chameleon—all for the low price of $54.95 + S&H, less than the retail price of Chameleon alone!

That’s right! Get the 7th Heaven Utilities, called “Powerful Productivity Enhancing Tools” by Macworld Magazine, for this low price. 7th Heaven lets you make System 7 what it should be; fast, colorful, informative, and easy to use. Seven utilities in one, 7th Heaven gives you more for your money, while giving you less headaches. With 7th Heaven, there are no Control Panels or Extensions to conflict with other software. All 7th Heaven applications are meant to work with one another to squeeze every ounce of color and power out of your Macintosh. Use 7th Heaven applications instead of memory and disk hungry alternatives to make your Macintosh as fast as it can be.

- **FinderExpress** - Fast Finder file copying - speeds up to 140MB per minute. Copy files 340% faster!
- **Calendar** - Desktop calendar with clock, notes and graphics - instantly available, and will never go out of date.
- **Chameleon** - The ultimate desktop pattern utility - over 100 cool patterns, import, export and editing capabilities.
- **FileMapper** - File mapping allows double-click launching of orphaned documents, even if you don’t own the application that created it!
- **RedAlert** - Colorized system alert icons - many color, gray scale and black & white icon sets to choose from.
- **Informant** - Complete system information & troubleshooting aid - lets you know your exact system configuration.
- **VectorPlasma** - Screen saver - low memory and CPU usage, background application aware.

Send your check or money order for $60.90 to: (in U.S. funds, MN residents add 7% sales tax)

LOGICAL SOLUTIONS, INC.
2124 University Avenue, Ste. 102
St. Paul, MN 55114-1838

Or for quicker service, use your Visa or MasterCard:
Call our order line at (800) 645-2495 or fax us at (612) 659-2498.
Companion Disk Offer

Each of the programs included on the *Totally Rad Mac Programs* disk is ready to use as is. For instance, DarkSide comes with 6 fabulous faders, Before Dark has 30 pretty patterns, and SndControl comes with 12 Star Trek sound effects. If these ancillary goodies whet your appetite, I have just what it takes to satisfy your craving for cool stuff:

★ 3 PICT images for use with PICT2Startup, ScreenChooser, and LCA!
★ 1 PICS animation for use with Lights, Camera, Action!
★ 17 Sound effects for use with SndControl, Sound Mover, and Startup_snd
★ 6 Faders for use with DarkSide
★ 56 Patterns for use with Before Dark
★ Updates and bug fixes as needed

All this and more is included on an 800-kilobyte, 3.5-inch companion disk stuffed to the gills with high-quality files suitable for use with *Totally Rad Mac Programs*. But wait, that's not all. Order before midnight and I'll throw in an amazing Ginzu knife and a customized version of Makin' Copies which actually speaks your own name in glorious digitized fidelity! (I'm kidding about the knife, but I'll really personalize Makin' Copies. If you have an uncommon name, please provide pronunciation tips.)

☐ *Yes, please send me the Totally Rad Companion Disk!*
   I've enclosed $5* cash, check, or money order (purchase orders, CODs, and credit cards not accepted) to cover materials, shipping, and handling.

☐ *No thanks*, but keep me informed of updates and other special offers.

Company ______________________ __
Name ____________________ ____ 
Address __ ____ ________________ __
City ______________________ __
State ______________________ __
ZIP ----------- --Country ____ ________ __________ _

* For orders from outside the United States, please add $2 to cover additional costs, and make sure your payment is denominated in U.S. funds.

(If you don't want to cut up your book, mail a copy of this page or simply write the necessary information on another piece of paper.)
The Macintosh is supposed to be one of the easiest computers to use. But even the Mac has its problems. That's when it's time to reach for *Murphy's Laws of Macs*. This simple, plain-English, problems-solving book gives you the answers you need and lets you have fun in the bargain.

Whether you're new to computers or just new to the Mac, you'll find a gold mine of useful information in this book. Learn how to buy a Macintosh computer, find the best programs for your Mac, get tips for avoiding Mac pitfalls and more.

You'll get all of this and more in an entertaining and easy-to-reference format. The Mac is a fun machine to use. *Murphy's Laws of Macs* helps you get more from your Macintosh.

SYBEX. Help Yourself.
**Totally Rad Mac Programs**

**GET A FREE CATALOG JUST FOR EXPRESSING YOUR OPINION.**

Help us improve our books and get a **FREE** full-color catalog in the bargain. Please complete this form, pull out this page and send it in today. The address is on the reverse side.

<table>
<thead>
<tr>
<th>Name</th>
<th>Company</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>City</td>
</tr>
<tr>
<td>Phone ( )</td>
<td></td>
</tr>
</tbody>
</table>

1. **How would you rate the overall quality of this book?**
   - [ ] Excellent
   - [ ] Very Good
   - [ ] Good
   - [ ] Fair
   - [ ] Below Average
   - [ ] Poor

2. **What were the things you liked most about the book?** (Check all that apply)
   - [ ] Pace
   - [ ] Format
   - [ ] Writing Style
   - [ ] Examples
   - [ ] Table of Contents
   - [ ] Index
   - [ ] Price
   - [ ] Illustrations
   - [ ] Type Style
   - [ ] Cover
   - [ ] Depth of Coverage
   - [ ] Fast Track Notes

3. **What were the things you liked least about the book?** (Check all that apply)
   - [ ] Pace
   - [ ] Format
   - [ ] Writing Style
   - [ ] Examples
   - [ ] Table of Contents
   - [ ] Index
   - [ ] Price
   - [ ] Illustrations
   - [ ] Type Style
   - [ ] Cover
   - [ ] Depth of Coverage
   - [ ] Fast Track Notes

4. **Where did you buy this book?**
   - [ ] Bookstore chain
   - [ ] Small independent bookstore
   - [ ] Computer store
   - [ ] Wholesale club
   - [ ] College bookstore
   - [ ] Technical bookstore
   - [ ] Other _______________________

5. **How did you decide to buy this particular book?**
   - [ ] Recommended by friend
   - [ ] Recommended by store personnel
   - [ ] Author's reputation
   - [ ] Sybex's reputation
   - [ ] Read book review in________________________
   - [ ] Other _______________________

6. **How did you pay for this book?**
   - [ ] Used own funds
   - [ ] Reimbursed by company
   - [ ] Received book as a gift

7. **What is your level of experience with the subject covered in this book?**
   - [ ] Beginner
   - [ ] Intermediate
   - [ ] Advanced

8. **How long have you been using a computer?**
   - [ ] years ________________
   - [ ] months ________________

9. **Where do you most often use your computer?**
   - [ ] Home
   - [ ] Work

10. **What kind of computer equipment do you have?** (Check all that apply)
    - [ ] PC Compatible Desktop Computer
    - [ ] PC Compatible Laptop Computer
    - [ ] Apple/Mac Computer
    - [ ] Apple/Mac Laptop Computer
    - [ ] CD ROM
    - [ ] Fax Modem
    - [ ] Data Modem
    - [ ] Scanner
    - [ ] Sound Card
    - [ ] Other _______________________

11. **What other kinds of software packages do you ordinarily use?**
    - [ ] Accounting
    - [ ] Databases
    - [ ] Networks
    - [ ] Apple/Mac
    - [ ] Desktop Publishing
    - [ ] Spreadsheets
    - [ ] CAD
    - [ ] Games
    - [ ] Word Processing
    - [ ] Communications
    - [ ] Money Management
    - [ ] Other _______________________

12. **What operating systems do you ordinarily use?**
    - [ ] DOS
    - [ ] OS/2
    - [ ] Windows
    - [ ] Apple/Mac
    - [ ] Windows NT
    - [ ] Other _______________________

Please complete this form, pull out this page and send it in today. The address is on the reverse side.
13. On what computer-related subject(s) would you like to see more books?

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

14. Do you have any other comments about this book? (Please feel free to use a separate piece of paper if you need more room)

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

Excellent Installation Instructions

The enclosed 800K, 3½" disk contains all of the programs covered in this book in a compressed archive. Before you can install the rad programs, you must unstuff the archive. To do so, turn on your Mac and when the Finder's desktop appears, insert the enclosed disk in an empty drive. Double-click the disk icon to open its window, then double-click the Rad.sea icon to launch StuffIt Lite. At the splash screen, click Continue to present a dialog box where you can specify a name and location for the Totally Rad Programs folder. Pick a hard drive with at least 1.6 Mb of free space, then click Save. An alert box shows the progress as StuffIt Lite unstuffs the files in the folder. If all goes well, click Quit after the alert box announces that the installation was successful and the following files should appear in the Totally Rad Programs folder:

- AudioClips
- Before Dark
- Bongo Bob
- DarkSide
- FKEY Master
- Kilroy
- Lights, Camera, Action!
- Makin' Copies
- MICN
- Momentum
- 99 Bottles
- PICT2Startup
- ScreenChooser
- ShrinkDown
- Shutdown Fade
- SndControl
- Sound Mover
- StartupSnd
- SuperApple
- TailDragger
- The Ripper
- Wacky Lights

Once these files have been unstuffed, follow the detailed directions in each program's chapter for installing the individual files where they belong on your hard drive. In general, all applications can be launched from within the Totally Rad Programs folder, whereas control panels and system extensions should be copied into the System folder for proper use. You may have to choose Restart from the Finder's Special menu for the installation to take effect. Enjoy!
Totally Rad Mac Programs

Customize your Mac with 21 of the coolest programs on the planet!

Totally Rad Mac Programs compiles the best in Mac freeware, shareware, and public domain programs. You get 21 awesome programs to personalize your Mac, plus easy-to-follow installation instructions, customization tips, and compatibility notes. Inside, you'll find:

- Spectacular start-up and shut-down sequences, hilarious sound effects, sensational screen savers, and handy utilities
- Programs that are similar to expensive commercial packages like After Dark, Chameleon, Now Fun!, Pyro, and Wallpaper
- Exclusive offers for valuable discounts on commercial programs
- A dozen authorized Star Trek AudioClips

All programs are System 7-compatible; most also run under System 6. Extensively tested and virus-free, these programs work with almost any Mac, including Performa, PowerBook, Quadra, and Centris models.

So why waste time, energy, and money trying to round up and test these programs on your own? Get them all here in one neat package, with the detailed explanations you need to make the most of your Totally Rad Mac Programs.

This book includes an 800K disk that decompresses to 1.6 megabytes of start-up and shut-down programs, sound effects, utilities, and lots of other cool stuff to make your Mac the hippest computer around.

About the author: Owen W. Linzmayer is a San Francisco-based freelance writer who contributes regularly to MacUser and Macworld magazines. The author of several other books on video games and the Macintosh, he has also held editorial positions at a number of personal computer publications.